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Introduction

The purpose of Rapid Reserver (RR) is to prepare geological reserves for scheduling in Alastri Tactical
and Production Schedulers.

Rapid Reserver creates blast masters, dig floors, grade control blocks and scheduling blocks for the
entire mining technical services team. It works by drawing lines to cut solids, so that mining blocks are
automatically closed, validated and adjoined to their neighbours.

Solids, blast boundaries and reserves are dynamically displayed and can be exported to any mine
design software, scheduler or fleet management system

This document provides step-by-step instructions for creating such a project, including instructions for
setting parameters, creating solids based on the current survey, working with blasts and mining blocks,
reporting and plotting the data of interest, as well as exporting the prepared reserve model file for
further use in mine planning.

Terminolog

User Interface Terms

Design window

The main 3D design area in the Network tab

Viewport Any 3D visualisation area

Tab Tabbed working area

Panel Interactive frame within a tab

Dialog A new window that opens to enter information
Dropdown A dropdown box that lets you choose from a list
Icon/Button A button that can be pressed

Checkbox A box that can be ticked on or off

Mining Terms

Increment The height of the bench, flitch, cut or lift

Block model Reservesfile

Parcel One-component material inside a given block (in the reserves file)

Block solid 3D object

Mining solid 3D object with either regular or irregular outline representing an area
of cut or fill within an increment of a phase

Blast solid A mining solid with an irregular outline

Phase Master solid to be sub-divided into increments and mining solids

Constraint A surface, solid or polygon used to delineate a composite solid

Named Polygon

Polygon including Blast Type as description
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Prerequisites

To complete the workshops in this series you will require:

Avalid 20-digit license key.

A personal login to https://www.alastricom/.

Rapid Reserver installed on your computer.

Download files:
a.Block Models CSVs: “pit1a”, “pit2a” and “pit3a”;
b.Pits and Dumps designs: “pit1_s1.00t", “pit1_s02.00t", “pit1.00t", “pit2.00t",

“pit3.00t", “dump1.00t”, “"dump2.00t", “dump3.00t" and “Ig1.00t";

c.Surveys: “topo.00t” and “EOM_Survey.00t".

N

System Requirements

The following information outlines the recommended system requirements to run the Alastri suite of
products. Asthe hardware required depends on the complexity of the mine and the amount of data,
meaningful minimum requirements cannot always be listed. Ultimately the only way to know whether
specific hardware will work for a specific mine site is to validate the software's performance during
the free trial period.

e Forlarge multi-pit mines with raw LIDAR surfaces and block models with 80M blocks the
requirements will be at the extreme end.

e The minimum requirements will only support small mines with a small block model and
surfaces with low triangle counts. Running Alastri Rapid Reserver on minimum system
requirements may slow the application response, depending on the size of the model. Use
recommended requirements for optimal use.

Component Minimum Standard Extreme
Processor Inteli5 Inteli7 Inteli9

Memory (RAM) 8GB 64 GB 128 GB
Operating System Windows 10 x64 Windows 10 x64 Windows 10 x64
Video Memory

(GRAM) 2GB 8GB 12GB

Monitor 1920 x 1080 Dual 1920 x 1080 Triple 1920 x 1080
Video Connection HDMI, DisplayPort, DVI, VGA - USB not supported

Video Driver Driver no more than 6 months old (OpenGL 4.6+)

Hard Drive Solid State Drive with at least 50 GB Free

Power Connection AC Power - Battery power not supported (plug in the laptop)

Network Consistent, reliable, high speed (>1 MB/s) connection to the Internet

Connection

NET 472
Software Microsoft Visual Studio 2019 C++ Redistributables
Prerequisites (https:/laka.ms/vs/16/releasel/ve_redistx64.exe)

Microsoft Excel
Keyboard and Mouse with a left mouse button, right mouse button, and

Input Devices middle mouse button/scroll wheel

Many IT departments block downloads of Microsoft prerequisites, so you may need to download them manually.
The installation error "Element Not Found" indicates that you must download and install these manually.

e  Microsoft NET Framework 4.5.1.

e Microsoft VSTO Runtime for Office 2010.
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First Principles

Rapid Reserver works by creating a master solid, partitioning that solid into benches and blocks,
overlaying the blocks against a block model and then dynamically calculating reserves.

This information is collected in four tabs: Setup, Designer, Report and Solid Lab.

The Setup and Report tabs tell Rapid Reserver how to read the block model and what reserves to
report for each solid. The Designer and Solid Lab tab are where solids are created.

I Setup II Designer I Report I Solid Lab I

2 ),
L =0 4 ' i o
Setup tab Contains a series of steps that must be completed to create a valid project. To

proceed to the next steps and run your model you'll be prompted to complete
every step of this tab.

Designertab  Containsthe 3D work environment to cut solids from benches.

Reporttab Allows the user to QAQC the reserves without leaving the application.

Solid Labtab  May be used to create pit solids and dump solids.

This document provides only a brief description of all the steps and tools for working with you mine
site reserves. For a full and detailed description, see Rapid Reserver Documentation section of the
main documentation portal.

The exercises in this chapter are for familiarisation purposes and are deliberately light on detail. More
in-depth discussion follows in the next section.

Unless otherwise noted, each exercise follows from the preceding exercise.
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Project Setup

Creating and opening a project

1. Download the latest version in the Alastri Hub and start Rapid Reserver.
2. Createanew projectand name it"RR. Demo Project". The main Rapid Reserver project
file is savedin "rara" format.

@ open X
5 of 10 Seats Available
e T v B Search Project files
- Organize = New folder . m @

Ml Desktop ~ Nome

& Documen Block Models
4 Downloac

Layers
Music emo Project_212.981
RR. Demo Project_21.2.98

& Pictures

82,221 k8

IR Alastri Rapid Reserver v21.2.933

File Tools Help

File i

[] create New Project v

=5 Open Existing Project, File name: | RR. Demo Project_21.2.981

When Rapid Reserver project is saved, multiple different files will appear in the save location.

rara Rapid Reserver projectfile

Jock Locks out afiletoone useratatime

old If the main project files are corrupted for any reason, the “.old" files can be

' restored as functional project files by removing “.old” from the file name
resultCache  Reduces scheduling time by saving results of previous runs

Saves triangulations external to the main project. Deleting the “.layers” file is the
same as deleting all layers from the project

Saves draped images external to the main project. Deleting the “.drapelmages”
file isthe same as deleting all draped images from the project

Jlayers

drapelmages

Example:
| demo_BenchBlocks_newmodel.drapelmages 1T1/11/2019 12:21 PM DRAPEIMAGES File 3033 KB
| demo_BenchBlocks_newmodel.layers 11/11/201912:21 PM LAYERS File 72,469 KB
m demo_BenchBlocks_newmodel 11/11/2019 12:24 PM Rapid Reserver 45,306 KB
| demo_BenchBlocks_newmodel.rara.layers T1/11/2019 12:24 PM LAYERS File 1KB
| demo_BenchBlocks_newmodel.rara.old 11/11/201912:21 PM OLD File 71,516 KB
m demo_DigBlecks_newModel 23/10/2019 12:02 PM Rapid Reserver 99,691 KB
| demo_DigBlocks_newModel.rara.drapelmages 23/10/2019 12:02 PM DRAPEIMAGES File 3033 KB
| demo_DigBlocks_newModel.rara.layers 23/10/2019 12:02 PM LAYERS File 72,469 KB
| demo_DigBlocks_newModel.rara.old 23/10/2019 10:08 AM QLD File 96,542 KB
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Setup tab

The purpose of Rapid Reserver (RR) isto prepare geological reserves for scheduling in the Alastri
scheduler.

Inthe Setup tab data is imported and information required for the inventory model created.

Geological Block Models

Pit Phase solids

Current Mine Surveys for depletion

Client Grade Control Databases can be imported

Information can be added to the inventory:

Data hierarchy created

New properties can be added

Bench structure added to the reserves

Material can be depleted/removed for the current project
Wall control parameters can be added

Within RR there are 4 places where data can be removed from the Inventory. This can be used to tidy
up remnant data which does not need to be scheduled, or temporarily remove data which does not
need to be scheduled in the course of the current plan.

1. Setup >Depletion Surfaces:
a. Depletion Surfaces can be added here, based on the latest mine survey.
b. Top Rlscan be set - data above/below these levels will not be included in the
inventory.
2. Setup>Phase Exclusion Areas:
a. Digitise polygons to include/exclude remnants or whole areas notto be included in
the currentinventory.
3. Setup>Bench Depletion:
a. Dataonwhole benches (or part thereof) can be removed.
4. Designer > Properties panel > Force Exclude checkbox.
a. Blocks can be selected inthe graphics screen and excluded.

Thefirst step in creating a project is to review the project settings.

1. Select the units of measurement. Use the Quick Set field to select the metric units.

2. Depending on which options are ticked in the Options section, different steps appear in the
Setup Tasks list. Inthe current project, we will need to tick the Use Block Model, the Fill Block
Model Gaps, and the Enable Dig Plans features.

Use Extensions: allows extra custom scripts to be added to project.

Use Block Models: toggle to use block models for reserving.

Fill Block Model Gaps: option to fill voids in block models with a default material.

Use Infrastructure: needs custom Extension scripts.

Enable Dig Plans: allows blast solids to be subdivided into dig blocks.

Enable Single Destinations: force one material type per dig block, for grade control

blocks.

Use External Grade Control Data Source: needs custom Extension scripts to read in

the customers database.

000 OTw

@
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h. Block Model Expand Distance: visible block models are clipped to the Expand Distance
around the current selection.

i. Maximum Grade Block Overlap: error threshold for overlaps of imported grade control
polygons, in percent.

3. Setthethresholdsfor error (Error Finders) and remnant blocks exclusion.

a. Setthe minimum block areato 50 bcm.

b. Discard Threshold ficlds: filters out solids below the specified area/width/volume.

c. Inthe Hatch Patterns area, select a pattern from the dropdown list to highlight different
areas for phase exclusion, blasts, or grade control.

@ Wall Control Designs

Tables step

Eachtable inthe Tables step is an ordered hierarchical address, such as
“Mine/Pit/Stage/Bench/Solid/Flitch/Dig".

e Longterm projects may schedule to the Bench/Blast level.

e For Shorterterm projects sites can schedule to Flitch and Dig blocks.

e Themore blocks are created in Rapid Reserver, the slower the final schedule is, so only
create downtothe level required.

Tables Type Name Assodiation Defauit Value Auto Unique Image
» Reserves i Pit v | |[» Mine Phase v Mine

g
g
B
3
emedide
e

© Wal Controls
@ Wal Control Designs
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1. AtableiseitheraPit or a Dump type. This determines whether the solids will be
reserved or not.

@Y « |V

Tables Type

§ Reserves Pi

Dumps

2. Add Flitch and Dig levels to the Reserves table.
3. Verify that the levels in the Association column are assigned correctly.
a. Levels may be associated as “Phase”, “Bench”, “Flitch”, “Blast” or “Dig”. Phase
levels act like folders (mine, pit, stage, pushback, ..) whereas the “Bench’,
“Blast”, “Flitch”, and “Dig" levels refer to specific mining terms.
b. Eachtable must have exactly one "Blast" level and exactly one "Bench" level.
All other levels (such as "Mine", "Pit", "Stage") are called "Phase levels".

Ifin the Settings step Enable Dig Plans option is ticked, then one “Dig” or one “Flitch” level are required.

4. Checkthe Auto Unique column to automatically assign blocks with unique names.
5. Selectthe relevantimages for each level.
6. Pressthe blue plusiconto runthisstep and proceed to the next one.

Block Model step

In the Block Model step, you will be prompted to load your block models.

1. Clickthe New button to open the Reservable Models Generator window.

2. Pressthe blue plus button and import block models CSVs: “pit1a”, “pit2a” and “pit3a”.

3. Inthe Import CSV file window, select the applicable parameters and set the Header Line
and Data Offset, if necessary.

a. Set the green Header Line to match the header text.
b. Set the yellow Data Offset to match the first row of data.
C. Press OK to finish.
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Setup

G| P b

< <Default>

Setup Task
gD Settings
gD Tables
Block Model
e Block Model Gap Filing
e Phases
) Fhase Properties
e Blast Properties
3 Dig Properties
e Bench Templates
e Depletion Surfaces
e Phase Exdusion Areas
) Phase Detals
e Bench Preconditioning
a Bench Depletion
@ Wal Controls
e Wall Control Designs

v ||

Solid Lab
Reserves Model

|y Open [ Edit &) Close
C:\Users\aniarmstrong\Desktop Ressfes Models\BM mapped. resmode!
Blod

@ Export

Reservable Model Generator o | x
Namg
Block Models B %X T ¢ @ ps
bm [x] [cH] Custom Variables
CSV File... Available Variables
Vulcan BMF... B
Bintab File...
— Lo
MineSight Block Model...
Celimiter Comment Charactes & Quote Character |*
[ BestFit Columns
teader tne [ | croose selected Lne | Dot Offset |1 %
LB LS ¥ z DK DY oz wol dt
Rest 2w 1200 0 n 10 10 1050 3010
ERRELL] 1200 10 1 10 10 1000 3000
Fielg 4 w070 1200 720 0 10 o 1000 3000
z‘ 5 1070 1200 70 n 0 0 1000 3000
:i' 6 |wm 1200 0 0 ) 1] 1000 3000
0 7 uwm 1200 70 It » 10 1000 3000
< ] w070 1200 760 10 10 10 1000 3000
v @ o 0n 1200 7 i 0 jt) 1000 3000
10 w7 1200 70 0 o o 1000 3000
1 un 1200 ] w 1 10 1000 3000
2 wn pr. U a w Y o w w0
13 w07 1200 810 0 a0 1o 1020 3000
14 w7 1200 820 0 0 0 1000 3000
R ol ||of
M
Cancel |>  Generate

When importing Block Model CSV, you'll see a preview of the first 100 rows of this CSV. It's a good time-
saving feature, as your site Block models CSVs can be of a very large size and take a long time to open.

Once the block model has loaded, its header fields are listed in the Variables panel on the right.

The Field column (on the left) lists the fields of the reserves model, and you will need to map them with
the fields from the imported block models.

Dragand drop N(“X") variable to the X (m) field, N("Y") variable to the Y (m) field, etc.

For the Volume field use the formula N("'DX")*N("DY")*N("DZ").

Forthe DryTonnes field use the formula N('DX")*N("DY")*N("DZ")*N("SG").
Forthe WetTonnes field use the formula N('DX")*N("DY")*N("DZ")*N("SG")/0.95.
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5% T e O ¢ ¥ OO ff & K-

Field Format ParcelMapping1 [c#] Custom Variables
b I\? % (m) Mone - N(XY Available Variables
@ ¥(m) None - N(YY)
©z(m Naone * N(Z) Enter text to search Clear
@ oxm None + N(DX?)
@ DY m) Mone ~ NCDYT) As Mumber As Text
© pz(m None ~ N(DZY) NCX) ™0 -
© Bearing MNone * N(Bearing”) YY)
A parcel None * CustomT("OreParcel) N('Z") (Z
¥, volume (m?) £ £20 -’W' N(DX") (DX
%, DryTornes #4550 = L NCDX P NEDY PN NSE) (DY
X FE - N{Fe") (D2
X AL - N(AD) T(56)
X, st » N(S7 T("Bearing”)
%, WetTornes ~ [N{DX Y NCDY ) NCDZ)N(SE)/0.95 | T(Fe)
X, Moisture * N('moi”) AR
(s
T(Tump_pct?)
T(lump_rec?)
T(lump_fe?)

Fields

Numeric fields use the N(“field”) syntax, and text fields use the T(“field") syntax.

New reserve model fields can be created by clicking the sum, weighted, and class icons located inthe
top button toolbar. These add new rows into the field list.

e =» @ . (X ¢ v ) 4

Field Format ParceliMag
7 X(m) None * N(XD
v Yim) None  NYD
v Z(m) None * N(Z9
¥ DX (m) None * N(DX)
¥ DY (m None v N(DY)
¥ DZ(m) None * N(DZ)
J Bearng None v N(Cvol)
A, Parcel None v NCvol)
r Volume (m?*) 2,820 * N("vol?
!' NewAdditiveField 2,220 -
3 Plant_Ral_Lump_DryTonnes 2,220 -
Al 2,220.00 v
St 2, 220.00 -
» I Plant_Rad_Fines_DryTonnes -
X Fe -
X A

X s
T, Textrield
TextField

L I B

L R

)

e Sumfields are summed together, such as volumes, tonnes, and gold ounces.

¢ Weighted fields are weight-averaged by their parent field, such as iron percent or
gold ppm.

e Classfields create subtotals of their parent fields, such as tonnes of Indicated /
Inferred / Measured.

> Create and map the fields for Fe, Al, and Si.

e Usethetop buttontoolbar to add the fields under the correct parent.
e Usethevariableslistto map valuesinto the fields.
e Selectthe appropriate format for each field.
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e Checkfor hintsinthe Errors panel below the fields.

If required variable is not available, you must create/edit it in the Script Editor window, which can be
accessed via the Custom Variables button.

Reservable Model Generator o[ x

o | L)|X T o & ¢/ ¥ Obn A =&~ Variables [
@04 ¥ Field Format ParcelMapping L cH] Custom Varizbles
Name Path @ xm fone - N Avaiable Variables \

pitla.csv = pit1a.csy \
9 Z2(m lone - N(Z A Clear
pitza.csv [ pitza.csv 9 2im ) \
» pitda.csv [ pitsa.csv @ or(m one « neDY) As Number AsText
@ o e I .- =)
P o =

ng I .7 ("OrcParcel")
G2 | e T

N(DX)N(DY)N(DZ)
NCDX)N(DY P NDZ)N(SE)

- N(Fe)

- NCAD)

- NS

+ NCDX)N(DY)N(DZYN(SG)0.95
+ NCmoi)

@O & ¥ s}
Name

» ParcelMapping1

o
» @ Error in bleck medel (pit3a.csv). Error in parcel (ParcelMapping 1), You must specify a mapping for field (Parcel).

Cancel ||[> Generate

Creating Custom Variable

To create a custom variable required for fields mapping and reserves model generation:

—

Press the Custom Variables button.

2. Inthe Script Editor window, customize the formula code.

3. Youcancopy sample scripts from the RR. Block Model Custom Variables section in
the main documentation space and paste them into the Editor window (for easy
access:. press the Help icon (Question mark) and navigate Rapid Reserver
Documentation > RR. Exercises > RR. Block Model Custom Variables).

Oy | P L&

Change the required values, such as the parcel and thresholds.

Verify that the code is correct by pressing the Compile button.

Ifthere are no errors, click OK.

The new custom variable will appear in the Variables list on the right in bold. Drag
and drop itto map it to the applicable field.

No o
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Reservable Model Generator e [ x|
Block Models o |[B[XT & @ el¢ O 8 [=/|&-] Variables 2
\@*H@I & |@ | Format ParcelMapping 1 Custom Variables

Name Path None ML Y] Avai\ab\a%
b pitlcsy = pitia.csv None v NCYD) 7~
None > N(Z7 er text to search... Clear
it2.csv it2a.csv S—
o EL None ~  NCDXT
pit3.csv |=5 pit3a.csv ol As Text
CustomT("Parcel”
using System; ~ CustomT("OreParcel")
using System.Collections.Generic; - f
using System.Text;
using System.Ling;
using Alastri.Scripting;
using Alastri.BlockModel.Engine.CustonVariables;
public class Parcel : ITextCustomVariable
{
1 public string GetText (CustomVariablesContext context)
11 {
12 double fe = context.N("Fe"):
L ) TCs)
4 if (fe > &0) return "hg";: = =
15 else if (fe > 58)  return "mg"; TClump_pct?)
i n ", T("fines_pct™)
Fas et S 16 else if(fe > 57.5) return "lgl"; . g
- = — 17 else if (fe > 56) return "1g2"; T(ump_rec)
o6 4 v [ED]L:! . else if(fe > 50) zreturn Pminw"; T(fines_rec?)
Name | @ | 19 else return "w"; T(lump_fe?)
> . -
}  ParcelMappingl T(ump_al")
free / T(Tump_si7)
Available Formulas Trfines. e
CustomVariablesContext.N(Name) P T:'ﬁ _I":
Returns the value in the current row as a number. 0 L fnesEl
CustomVariablesContext.T(Vsme) J T(fines_si")
Returns the value in the current row as text. T(mai)
CustomVariablesContext.MetaN(/Name) - T(blockId?)
Dabiiemm tha sl P
OK
| Cancel H [» Generats

Once all the fields for the pit1 are mapped, copy or exportthem for further pasting in pit2 and pit3

models.

it

v N(Y)
v N(Z)

5]

Export Fields
Export Selected Parcel Mapping
Export All Parcels and Mappings

>
reserve model.
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%% T s @ & B /A = & Variables 2
Field ParcelMapping1 [c#] Custom Variables
@ xm v NOXO) Available variables
¥ Ym * NCYD
9 zm v N(Z) nter text to seard Clear
@ ox(m) v N(DX)
@ or(m) + NCDY) As Number As Text
@ oz ) N o (“vorcet)
@ Bearing * N(Bearing?) I :stom (" OreParcel”)
» A Parcel + CustomT("OreParcel”) N(X ™

¥, volume (m?) * N(DX)N(DY)N(DZ) T
%, DryTonnes > NCDX)™N(DY)"N(DZIN(SG?) N(2 (Z

% - N(Fe) )

X a > NCAP

X st - N(Si%
I

67%
Block Model 1/3: Writing blocks Cancel
I All fields are mapped | Is
I No messages in Errors panel I

Once the reserve model file has been generated, a block model summary is displayed for each
loaded block model.

¢ Use the Min/Max toggle to inspect the data for missing or rubbish values.
e Checkthe material types, tonnes and grades for ballpark accuracy.

Reserves Model
(2 New (= Open ([ Edit & Close = Export
\\sauron\Shared\07_Technical Documents\1. Public\02_Updated Training Materials\RR_in progress\Project files\Block Models\Resmodel_1_nov.resmodel

Block Models
Source
Name -
Block Count Extents
pitla.csv
pitl.csv
336,000 blocks (2,008 | 297 | 600) x (2,808 | 1,697 | 900)
pit2a.csv
pit2.csv
80,000 blocks (1,002 ] 1,394 | 660) x (1,802 | 1,894 | 860)
pit3a.csv
pit3.csv
50,000 blocks (3,045 | -155 | 700) x (3,545 | 345 | 900)
Reserves Summary
Fields <All> Hg ] mg
Field Value Min Max Value Min Max Value Min Max Value
{ Volume (m?) 336,000,000 1,000 1,000 34,294,000 1,000 1,000 5,259,000 1,000 1,000 3,210,000
Z DryTonnes 924,000,000 2,750, 2,750 94,308,500 2,750 2,750 14,462,250 2,750 2,750 8,827,500
X FE 27.09 Q40 67.38 61.78 59.00 67.38 56.42 54.00 58.00 58.54
x AL 0.73 0.00 10.00 5.04 0.00 10.00 5.27 0.00 10.00 5.20
X SI 168 0.00 23.00 12.92 2.50 23.00 12.09 0.00 23.00 12.97
Z, WetTonnes 97631,570 2,895 2,895 99,272,104 2,895 2,895 15,223,421 2,895 2,895 9,292,105
X, Moisture f.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1 0.1
‘ ’
Parcels | <All Parcels> -
Fields | <Al Fields> -

Pressthe blue play icon to run this step and proceed to the next one.
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Block Model Gap Filling step

Option tofill voids in block models with a default material. Where the mining solid surface is outside the
block model extents. Gap filling material should be waste, if it could be anything else, discuss with the
geologists who prepared the blockmodel. If gaps are present and gap fill is not used, the schedule will
apply zero tonnes for this mining area.

1. Inthe Gap Filling Presets column, add a new preset for the material used to fill the voids.
Name it, for example, "W" (waste).

2. Inthe Parcel field select "w" (waste) from the dropdown.

3.SetDryTonnesto 2.75and wetTonnesto 2.895.

4. Press the blue play icon to run this step and proceed to the next one.

File Tools Help

Setup Solid Lab
iy > L2 = Gap Filing Presets — ——r——
4 )
p=04 . o Y ;IA Parcal - 'i
= <Default> = ||i2h| (% Nome 2., Volume 1
2, DryTonnes 275 |
Setup Task b Waste
Fe 0
& Settings - .
&) Tables
= X si 0
Xr
Block Model Gap Filing X 0
X Mn 0
e Phase Properties { Lo 0
e Blast Properties i X 5 ]
a Dig Properties l T, WetTonnes 2.895 I
a Bench Templates [, Maisture 0

@ Depletion Surfaces
e Phase Exdusion Areas
@ Phase Details

ﬁ Bench Preconditioning
& 8ench Depletion

a Wall Cantrols

e Wall Control Designs

Phases step

Inthe Phases step, the user is prompted to create/import phases for later reference in the project.
Note thatthe names and order of the phases in the entire project are specified in this step. Make sure
thatthe phases are added, named and listed in the correct order.

Each phase is defined by a closed master solid.
1. Importupdated and new phases.

If you do not have closed pit solids (as in this training project), navigate to the Solid Lab tab section to
generate them from designs.

2. Youcanimportfrom afile, Solid Lab tab, or a third-party package
(Vulcan/Minesight/Surpac).
3. Pitsolids must be closed (NOT open pit designs).
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If you have closed pit solids:

= Q 4/¥ B @ [l soipts ZPlane | ©Q (F 4@ Layers a
Name Solid Order | Color 8218 v o ® 118~ || Toals ~
pit1 s1 22,243,026 m* ¥ 0 - 7 = ®0E e
D 0 391 670 M3 v 0 - e @5%7/v

™ T v
f B3 Open “lepoist B S E-
H . i~
t1 s2 - -
T “ v | D S Search Layers g ;:tzj g E:I‘ % w1
% pit3 & o -
Organize » MNew folder Ex- @ @ Dumps @& E:]] % 77
._ 7
: Block Models A Name Date modified Type Surveys & G -
RR_in progress [ ] bf1.00t 1/11/2021 10:43 AM 00T File
Screenshots [ dump1.00t 00T File
& OneDrive D dump2.00t 00T File
[ durnp3.00t 00T File
@ OneDrive - Persenal D EOM_Survey.00t 00T File
o This PC [ finalcut.0ot DOT File
- [ finalCut2.00t DOT File
- 3D Objects [ 1g1.00t 00T File
[ Desktop [ pit1_s1.00¢ 00T File
Documents D pit1_s1.dtm DTM File
3 Downloads [ pit1_s2.00t 00T File
B Music [7 pit1_v2.00t 00T File
&= Pictures D pit2.00t DOT File
B videos ] pit2_bf.00t DOT File
5 b o [ pit3.00t 00T File
& Performance 55D (C:) ] topo.00t 0OTFile
¥ Network v < >
File name: | "pit2 BF.O0E" "pit3.00t" "bF1.00t" "dumpl.00t" "dump200t" ~ | All Supported Types (%00, ".dtr ~
I (1,121.95 | 1,248.48 | 875.52) I

Use the vertical slider (between the phases list and the view area) to check for overlaps.

e Qverlapsare a problem when material is included in multiple phases leading to double
counting of tonnes - this must be fixed. So each block is mined only once.

e Intheimage below see thatthe same areais used for 2 different purposes: first Pit1is
mined out, then the area is used as a backfill. The block is mined once, the areaisthen
available to backfill with waste.
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p) 1
=00 1000 — -
1999 Tpep 0:500 My JUIA GeForce RTX 2070/PCle/SSE2 | OpenGL v4.6.0 NVIDIA 471 68

(2,928.02 | 1,532.64 | 820.04)

e Toavoid double-counting tonnesin an overlap, revert to the Solid Lab and use the
Subtract Solids function to clean up the data.

Setup | Designer MotReady | ReportNotReady [ Solid Lab

@0 @ +/[v G adopeatn (@) 4 (9] [B] B ©

Solid Operation Set Create Solid Above All Surfaces (]
b pitl s1 X Creates a solid from extruding all surfaces
't1_ 5 upwards, then subtracts the solid under each
pitl_s

pit2 Create Solid Above Any Surface

- Dc Creates a solid from extruding all surfaces - -
pit3 upwards.

dump1

Create Solid Below All Surfaces
dump2 x Creates a solid from extruding all surfaces
dump3 downwards, then subtracts the solid above - -

finalcut Create Solid Below Any Surface
la1 x Creates a solid from extruding all surfaces
bf downwards,
1
Create Solid From Polygons - T
Creates a solid by extruding a polygon upwards
and dowvenvards.
Create Solid Above Plane

Creates a solid from the region above & defined
plane.

Create Solid Below Plane

Creates a solid from the region below a defined
plane.

Unien Selids
Unions two or more solids together.,

Intersect Solids
Returns the intersection of two or more solids.

Subtract Solids |
Unions the indusive solids mgemhmen
subtracts each exduding solid from the result.

Translate Solid or Surface
Translate a single solid or surface.

Llations: 5

4k

o[]S & @ 6

Reduce Complexitv

Page 16 of 75



micromine
alastri

To update the solid for a given phase, click in the Solid dropdown and select Geometry from File or

from Layer.

Mame

b pitl_s1
pitl_s2
pit2
pit3
dump1

Solid

Color 820

Crder
22,243,026 m
39,391,670 m?
15,302,092 m?
9,644,949 m? ~

15,868,445 m? +

o o o o o

4 4 4 4 A

Choose Phase Solid

Description

E Export Geometry

IL_“,‘-" Select Geometry from File “g" Select Geometry From Layer I

# cancel cf OK

When updating solids, avoid deleting them and adding new ones, as it will prompt you to re-populate
phases details and other settings. Always re-import solids to update phases, instead of deleting them.

Phase/Blast/Dig Properties steps

If extra properties (that are not mapped across in the Resmodel) are required for later scheduling

purposes they can be added here under the relevant step.

o Phase Properties step provides option to create properties for each phase. This might be
usedtoflag some phases for special treatment, such as backfill ramp solids vs. reserve

solids.

o BlastProperties step can be used to assign a tag or a value to a blast for use in schedule

software downstream.

o DigProperties step can be used to assign atag or a value to a dig for use in preschedule

software.

Setup Task
& Settings
& Tables
& Block Model
& Block Model Gap Filling
&) Phases

& Phase Properties
& Blast Properties
&) Dig Properties

Bench Templates
e Depletion Surfaces
e Phase Exdusion Areas
@ Phase Details
e Bench Preconditioning
e Bench Depletion
e Wall Controls
@ Wall Control Designs
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1. In the Blast Properties step create a new property for Density (Default 2.75).

2. Add a PctDrilled property - for a schedule that has drilling. Default is set to OFF (0), in the
Designer tab you can set blocks as already drilled or partially drilled (have to scriptin
drilling in the Scheduler).

3. Add a property for Bore — default is set to OFF (0), in the Designer tab can switch to ON (1)
for blocks with Bores. Allowing scripts to be written in the Scheduler and add a delay
around moving bores.

a. Ifyouselectthe Choice property type, create comma-separated properties (0,1
or OFF,ON) that can be selected from the Default Value dropdown.
b. Ifyouselectthe Number property type, enter a numeric Default Value.

Setup | Designer | Report | Solid Lab

)
&
2 <Default> - |28

Property Type Default Value Comma Separated Choices Min Value
0 100000

Number v 2.75

Setup Task
@ Settings
@ Tables
@ Block Model on
- L
@) Block Mode! Gap Filing

@ Dig Properties

Bench Templates step

Inthe Bench Templates step we create the bench height options that can be applied to phases. You
may choose a single template to cover all pits or have multiple templates for different mine areas.

Click the blue plus sign icon in the Bench Template panel to add a new template.

1. AddaNew Template for pit bench, rename it to “Pit_10m".
a. Inthe Bench Naming field tick Bottom.
b. Setbenchtemplate heightto10.
c. Ensurethatthe template fits the pit design (Pit1_s1). The red template should
match the pit solid contours, without offsetting.
2. Addanewtemplate for dump lift,rename it to “Dump_20m”".
a. Inthe Bench Naming field tick Top.

b. Setbench (lift) template height to 20.
c. Ensurethatthe template fits the dump design. The red template should match

the dump solid contours, without offsetting. For Dump1a template set to 20m lifts
will be offset against the design, as shown below.
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Setup | Designer NotReady | Report NotReady | SolidLab
|@}H > | T ? @0 #F =& peften Result
L L Bench Template | AddtoTop | Name Value Flitches Name Span (m)
| <Default> - ||| 1 Height{m) 0 900 830 => 900
el ) Pit_10m @ remove
Setup Task Dump. 20 - 30 860 => 830
@ setings et I | € Add to Bottom | 860 840 => 850
@ Tables » 840 820 => 840
@ Block Model _ BenchNaming 520 800 => 820
(&) Block Madel Gap Filing @ Top 800 780 => 800
(&) Phases © Bottom 780 760 = 780
(@ Phase Properties 760 740 => 760
(&) Blast Properties
) Dig Properties
. Bench Templates Phases
- HEREC 3] H o
pit1_s1 bR
) Phase Exclusion Areas pitl_s2
&) Phase Detais utz_
) Bench Preconditioning =
e Bench Depletion b :um n
e Wiall Controls - DZ
& wall Control Designs ome
dump3
lg1
(3,202.91 | 1,088.32 | 750.00)

To fix, set the RL for the template used for Dumps1and 2.

Add a new template for dump offset, rename it to “Dump_Offset_20m".
Select “Add to Bottom”.

Add Reference Level =10.

Set Height 20m above and below the reference (RI).

N N

Setup | Designer Not Ready | ReportNotReady | Solid Lab

lal

S » |[2] 00 @ EE |
. B @ AddtoTop | MName value Fltches Name Span (m)
|17 <Default> -/ |@) (™) ot 10m (@ remoe || L|Meshtm 2 310 830 => 510
Setup Task Dump_20m 2 RL(m) D 890 870 => 830
@ settings V" Dump_Offset_20m 3 |Heght (m) |20 870 850 => 870
@ Tables 1 850 830 => 850
@ Blok Model _ BenchNaming » 830 810 =>830
& Block Model Gap Filing @ Top 810 790 => 810
@ phases O Botiom 790 770 => 730
(@ Phase Propertes - 770 750 =» 770
(&) Blast Properties 750 730 => 750
(& Dig Properties
| Bench Templates Phases =
) Depletion Surfaces pitt st e
& Phase Exclusion Areas pitlisZ
@ Phase Detais mz'
& Bench Preconditioning nitz i
) Bench Depletion dumal !
& wal Controls m;z— ;
& Wall Control Designs —

(1,997.89 | 2,473.28 | 870.13)

Check Dumpland 2 using the new template - the red template should fit the lift design.

5. Rename Dump_20m to Dump3_20m.

Naming templates should be the same as the Phase they apply to. It will help to choose the correct

template in the Phase Details step.
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Exercise 1. Create a mixed-height template

1. Press the blue plusiconto add a new bench template.

2. Rename it to “Mixed Height".

3. Inthe Definition panel, press Add to Bottom.

4. Changethe threshold RLto the elevation where the bench heights change (setto 770m).
5. Setthe bench height above the threshold (set to 10m).

6. Setthe bench height below the threshold (set to 5m).

7. Review how this template fits pit3 solid in the viewport.

S0 ¢ ¢ =B Definition —
Bench Template &) AddtoTop Name Value Flitches Name Span (m)

Pit_10m & Remove 1 |Height (m) |10 800 800 =>3810
Dump3_20m 2 |RL(m) 770 790 790 => 800
Dump_Offset_20m 3 |Height(m) |5 780 780 => 790
lb Mixed Height I S 770 770 =>780
=L 765 765 => 770

Top [» 760 760 =>765 |
755 755 => 760
750 750 => 755

Phases

pttst | ||
pitl_s2
pit2

I» nit3 |
dump1

dump2
dump3
lg1
bf1
pit2_bf

0 S0 100 150 200 250 ;00 350 400

2499 fps | 0.400 ms/T NVIDIA Corporation NVIDIA GeForce RTX 2070/PCIe/SSEZ | OpenGL v4.6.0 NVIDIA 471.68

(4,075.93 | 631.56 | 781.44)

Exercise 2. Create a bench template with flitches

1.
2.
3.
4,

Pressthe blue plusiconto add a new bench template.

In the Definition panel, press Add to Bottom and change the heightto 12 m.

In the Flitches column enter the comma separated flitch heights (4,4,4).

Inthe Phases panel select pit1_s2 and review in the viewport how this template fits
pit1_s2 solid at the 876RL.
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Setup | Designer NotReady | Report NotReady | SoldLab |
| P b ? |©@8 ¢ ¢ |&/[E || oefin —
Bench Template @ AddtoTop Name value Flitches Name | Span (m)
& <Default> v (&) | Pit_10m © remove | L | Height(m) 12 3,4,4 | 912 912 =>915 => 920 => 924
Setup Task Dump3_20m 900 900 => 904 => 908 => 912
& Settings Dump_Offset_20m . 888 888 => 892 => 896 => 900
@ Tables Mixed Height “|» 876 876 =>880=>834=>888
& Block Model S| 12m with fitches ] Bench Naming 864 864 =>868 f 872 =>876
(® Block Model Gap Filing — O Top 852 852=>85 f>860 => 864
@ Phases @ Bottom 840 840 => 844=> 848 => 852
(& Phase Properties 828 828 =>83 =>836 => 840
(@ Blast Properties
@ Dig Properties
Bench Tenplates flmses Ol e eQ B #a
@ Depletion Surfaces L
© rhose Exckmon s -
@ FPhase Detais pit2 P
& Bench Preconditioning pr3 -
@ Bench Depletion dump1
@ wall Controls dump2
@ Wall Control Designs dump3
la1
bfi
pit2_bf

1249 1ps | ©.800 ms/r

(2,535.57 | 308.98 | 774.50)

Once you are satisfied, press blue play button to proceed to the next step.

Depletion Surfaces step

Update Phases with latest mine survey.

> Onlyimport blocks relevant to the current schedule.
» Top RLs can be set — data above/below these levels will not be included in the inventory.

—

Add a depleted surface survey.

2. Selectthe phasestoapply this survey to. Use the <CTRL>and <SHIFT> keys to select
multiple.

3. Usethedropdowns to select Upper and Lower depletion surfaces to be applied to the

selected phases.

Inthe Layers panel, display the End of Month surface and check the result in the viewport.

Press the blue play icon to run this step and proceed to the next one.

o~

port Not Ready | SoldLab
Depleion Surfaces e ea B #m Layers )
e 49 B ools -
—
s, [ ChooseLayers °
» Eom 2 1
- %) % &~
[ElENES . .
Neme z
» D& P B -
0 & D o
0 & surveys iH-
W &piECM Survey
[ & ton:

20000 EOM _Sur
20000 EOM_Sur

20000 EOM _Survey
» 20000 EOM_Survey

To
20000 {none)
dump3 20000 {none)
lat 20000 {none)

Upper Depletion Surface
Bottom RL
Lower Depletion Surface

500 1000 1500 2000

44284041y BTORIE 1< RTX 2070/ PE1eSSE2 | OoentL v4.6.8 RVIDIA 471,88
(1,420.58 | 61689 | 928.74)
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Phase Exclusion Areas step

When the Depletion Surface has been applied to the pit phases, in Phase Exclusion Areas step we
can remove remnant material from the reserves.

1. SelectZtoview the pitin Plan view.

2. Setthe vertical slider to identify the areas to remove - remnants on the wall <1m thick.
3. Draw a polygon around the areas to keep for scheduling.

a. Ifmistakes are made in digitizing, use the editicons to move points etc.

If required, you can include/exclude whole areas not to be included in the current inventory.

Phase Details step

In this step you may update the table, block model, bench template, and default properties for each
phase, including:

Update phase details for all phases including:

Table Type:is it Reserves/Dumps/Backfillsg

Increment Templates: what are the bench heightse (Ensure that the correct template
is applied).

Block Model: which block model to reserve frome (For dumps = (none)).

Block Model Fill: which material to fill block model gaps witheg (waste).

Design Position: elevation of exported polygons (top or bottom of bench).

Silhouette Type: select “Expanded”, “Normal”, or “None” silhouette type.

Expand Distance: this value should almost always be left at the default 50 meters.
Bench Tolerance: threshold depth for eliminating skirts and brims from bench solids.

n

© N W
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Setup

&

4l <Default>

agd)

@

Setup Task
(@) settings
(&) Tables
(&) Block Madel
(&) Block Model Gap Filing
(&) Phases
@ Phase Properties
@ Elast Properties
(@) Dig Properties
(&) Bench Templates
@ Depletion Surfaces

&) Phase Exdlusion Areas
Phase Details
& CCnoh Preconaimoning =

e Bench Depletion
e Wall Controls
e Wall Control Designs

Solid Lab

+ Reserves
+ M1
= P1
» P101
» P102
P2
v P3
» Dumps
v Backfills

Grouped Fields

5l Scripts

Increment Te...J| Pit_

Elock Model

Block Model Fill § w

Design Position

Sihouette Typel Expanded
Expand Distan.§ 50

Bench Toleran

Generate Panels

Width (m) 1000
Height Bench
Thickness {m) 0.5

4 €Q B #m

"o o
A

@ | Block Model Extents

Available Fields

¥ show Depleted Solids

Table Name
Design Position .
Blodk Mode! Tl e
Block Model Fil BStErss
Expand Distance 760
Increment Template 750
» 740

730

720

710

800

1000

Q 200 400 600
- -

769 fos | 1.300 ms/T  NVIDIA Corporation NVIDIA GeForce RTX 2070/FCle/SSEZ | OpenGl v4.6.0 NVIDIA 471.68

(-176.57 | -702.43 | 760.50)

Make sure that each level is assigned with a unique name. Otherwise, you won't be allowed to
proceed to the next step.

Bench Preconditioning step

The Bench Preconditioning step allows users to send material between benches where it makes

sense to do so. Common scenarios where this may occur are sump shots, shallow contour areas and
ramp preconditioning. This step should not be used to send remnants to the below benches. This can
be achieved in the next step (Bench Depletion).

This step is exclusively to configure contour and ramp shots. DO NOT use this step to deplete benches

or flitches!

§) tlock Mode Gap Filng
 Phases

L 4
@ Bock Model
@
@

hame
¥ Reserv
®m
wr
- W P01
w0
o =0
T
o 0
LA
w80
i
v
o
o a0
™
o
w
Legend
Hame Color

b Above Thicness Theshoid [l ~
Below Thicness Threshoid [l ~

Other Sihouettes
Hame ® Color
» Bench Above « -
Bench Below = Il -

This step is excusively to configure contaur and ramp shots. DO NOT use this step to deplete| Ramp Shot Configuration

V| ramo shot Mnimum angle (degrees) ;:

Ramo Shot Maxmmum Angie (degress) [
Cepth 3
Clear Existing Designs

Losy | sRie)

Contour Height

Lot to Upward Faces o]

Cear ExisingLines i/
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Defining Areas

Areas within the bench to be reallocated need to be defined by a closed polygon that can be created
using the CAD tools in the viewport toolbar. The CAD tools are found in various other steps within
Rapid Reserver and behave in the same manner, except for two buttons, Generate Ramp Shots and
Add Contours, circled in red in the figure below.

e ©Q B tmE s Bsrex 3T s 2E2ss 268 256G
Reassigning Material

Choosing what to do with the material enclosed within a polygon can be made by right-clicking on the
polygon and selecting an option from dropdown.

Do Nothing  Ctrl+W
Ctrl+R
Ctrl+Q

Ctrl+E

Remove
Send Up
Send Down

Itis important to understand, that the benches dealt with in Bench Preconditioning are based on the
Original Phase Solids, not the depleted Phase Solid. This means that material sent between benches
can affect the final silhouettes of the benches. Two simple examples of this are shown in the images
below.

wmm Bench Silhouette mmm Bench Silhouette

\ Lom \ -5_0'“

& Send down § send Down

\ Lo L.

\ L -
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Bench Depletion step

To remove or Send Down bench/flitch material of a thickness below specified:

SN AENIES

Setup Task

Double click a bench to select it.

Use the vertical slider to visually display areas to be excluded (thickness < 4).

Digitize a polygon around an area to remove/send down — press <Esc>when finished.
Click the drawn block - it will be shown in yellow.

Right-click to display a list of options, available for the selected material. The selected
material can be removed or sent down to be mined with the material of the bench below.

Setp
|| P w
4 <Default> |G | ~ ¥¥ Reserves
© settrgs
© Teves

© Sockiece )
@ Bk ot GaoFang B

mm|

You can tick a box to remove an entire bench/flitch (if the remnant material percentage is too high).

Name
~ ¥¥ Reserves
-8B m
- WPl
- W P101

EstCon

100.0%

B 780

; 770
B 760
B 750
B 740
B 70
B 720
B 7w
B 70

- W P102

B 590

45.5%
48.7%
0.0%
0.0%
0.0%
0.0%
0.0%
0.0%

34.7%
16,9%

40.3% Vi

880
870
860

B 850

17.7%

11.4% 17

The EstCon (estimated contour) column provides users with a high-level estimate on whether or not
remnant material may be present within a flitch. This number is not used anywhere else within the
software and is by no means accurate. The higher the number, the higher the change there is material
that needs attention.
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v' The grades and material types will the same as those of the new bench. The
information is not transferred to the new bench, just the extra tonnes.

v' Thisisusefulin a short-term schedule. Generally irrelevant in a long term and this
material could be removed.

Itis important to understand, that the benches dealt with in Bench Depletion are based on the
Depleted Phase Solids, not the Original Phase Solid. This means that material sent to the flitch below
will be trimmed by the silhouette of the receiving flitch. A simple example of the behaviour is shown
below.

== Bench Silhouette

\ Lo

& send down

\ J..

S35RL

v' Material from the flitch above gets trimmed by the silhouette of receiving flitch below.

Wall Controls step

The Wall Controls step allows users to specify blast properties such as wall edges and presplit edges.
This may be used to calculate drill and blast values in scheduling software downstream.

Wallis set by default. Press blue plus icon to create new wall controls techniques specific for your
project, such as pre-splitting, scaling or meshing, if required.

Setup Solid Lab
£ N = x v $2/[4% O D |&
& || & b= H
Name Color

= <Default> - | (&) (= S 7 J— - =
Setup Task Scaling -

@ Settings Presplit hd

& Tables

& Block Model
& Block Model Gap Filling
&) Phases
& Phase Properties
& Blast Properties
& Dig Properties
& Bench Templates
& Depletion Surfaces
& Phase Exdusion Areas
& Phase Details
&) Bench Preconditioning
&) Bench Depletion

I Wall Controls I
@@ Wall Control Designs
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Wall Control Designs step
In this step you have an option to edit wall control properties by benches.
Example: extra properties to define activities that only occur in a wall shot.

Here area defined as Wall will have Trim blasts, with the rest of the bench having Production blasts.
With further scheduling, rules can be set so that the production blasts in front of a Trim blast must be
mined first.

Areas where Pit1_slis adjacent to Pit1_s2 will not require Trim blasting. So this wall should be removed.

1. Select bench required from the Benches tree, it will be displayed in the main viewport.
2. Checkthe Wall Control for Painting.
3. Selectthe Remove Wall lcon.
4. Un-paintthe area where wall control is not required (adjacent phases).
5. Use the horizontal slider to adjust the size of the paint brush.
Setup Solid Lab
&> | ? O o4& B #m -_./ g
é <Default> v ,:j 2 Benches --E--E-_-------E--E-_E-->-->v ______ } 2
S ~ ¥ Reserves - / i %
éSEﬂmgs ” ?'M'lpl | (7] “xi
3 ;T:;ode\ ~ Wpio A i
(@ Block Mode! Gap Filing |80 |
(@) Phases 830 i
& Phase Properties s 3
@ Blast Properties & 850 1
& Dig Properties " 850 i
@ Bench Templates & 840 i
& Depletion Surfaces " 830 !
(@ Phase Exdusion Areas W 520 !
(&) Phase Detais & 510 i
© Bench Preconditioning D & 500 ] :
& Bench Depletion ﬁo |
& wall Controls w 780 i
| Wall Control Designs ] w0 i
& 760 - i
- Wall i
Visible  Painting  Wall Control i
[ MM wal ] i
Scaling H
» Presplit 3
1] 10-0 200 300 400 s00 §
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Exercise:

Click on every single bench of the Stage 1(P101) and remove walls adjacent to Stage 2 (P102). Since
these stages are adjacent, presplitting is not required on the neighbouring walls.

Benches R e et e .
«~ ¥ Reserves -
-8 M
- WP P1
~ W P101

¥ 890
W 880
w870
W 860
© 850
W 840
W 530
» W 320
¥ s10
800

i
i
1
i
1
1
i
1
i
i
1
i
1
i
i
|
i
1
i
i
|
i
|
i
i
]
i
|
i
i
i
w0 i
!
i
1
i
i
|
i
|
i
i
1
i
]
i
i
|
i
|
1
i
1
i
i
1
i
]
i
i
1
i
]

¥ 780
v

Wall where Stage 1 is adjacent to Stage 2
and presplitting is not required

& 760 -

Visble Paintng Wal Control

i
|

i

1

i

i

i

1

V! V wal |
Scaling H

1

» Presplit [
1

i

1

i

1

[1] 50 100 150 200 250 300 350 400 450 H

|

Rotation H
11010 0ps L0900 ME/T _ _ _ __ oo oo WYIDIA Corporation NVIDIA Geforce RTX 2070/PCle/SSE1 | ORentGl v4 60 NI 018 871,68

Run Setup steps

When you have completed all the Setup steps of the Setup Task list, click the blue play button to run
the last step or all steps to confirm and move to the Designer and Report tabs.

Setup Solid Lab

]
v
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Solids Lab tab

All benches in Rapid Reserver are cut from a master solid. These can be imported as existing solid files
or created in the Solid Lab tab.

Setup | Designer | Report | Solid Lab

The Solid Lab tab consists of four main sections, shown in the image below:

Setup | Designer | Report | Solid Lab

QU Q @ v (% addoperation ~ (@] (4| ¥ P B O b ©Q E #a ‘
Solid Operation Set Operaiion Topuks ) [PHE S 44 | | Tools ~
ptlsi 1 Create Solid Above All Surfaces ‘ Name @8 0

t1_s2

D'u_i Surfaces v ‘1 v i Pits ® & /// T

pi

= Result .- * \ oot B G-

dumpl 2 Create Solid Below All Surfaces @ pitLs2 ® @H-
: Surfaces B Viewport @ pi2 s QM-

dump2 for viewing results of operations and imported layers @ ot & &[]

dump3 Result N [ Dumos 'YL

finalcut 3 Intersect Solids & dumpt % QH-

lg1 » Solids #1,#2 v & dump2 ® L]~

bf1 Result - & dump3 s QM-

» Intersection @ ot ® QW

Operations Panel - v i@ Surveys B @
main pane| for adding operations and interacting with them

Solid Operation Set Panel Qeovsey ® @H-

for creating and listing all & topo ® &0
the operation sets & Updatedsurv.. @ & [ -

Layers Panel
for importing and managing
surfaces and solids triangulations

1] 500 1000 1500 2000
- -

233 7p< §0.300 ms FVIDIA GaForce RTX 2070/PCle/SSE2 | OpenGl v4.6.0 NVIDIA 471.68

Grid Size for Surface Calculations: 5% (1,227.78 | 814,37 | 789.19)

. = Operati v . . .
Click the Add Operation button S - to display a list of the available

operations. Each operation performs a single boolean step and a number of these steps are
used in concert to create the final result.

Operations from Add Operation dropdown are explained in table below.
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Operation Description

. If multiple surfaces are overlapping, this option will use the upper triangulated
gﬁ?l}ﬁcasggg Above surface of the overlapping surfaces as the base for the solid being created. Then

this surface projects up to create a closed solid.
Create Solid Above If multiple surfaces are overlapping, this option will use the lower triangulated
Any Surface surface of the overlapping surfaces as the base for the solid being created.

If multiple surfaces are overlapping, this option will use the lower triangulated
Create Solid Below surface of the overlapping surfaces as the top for the solid being created.
All Surfaces

Create Solid Below If multiple surfaces are overlapping, this option will use the upper triangulated
Any Surface surface of the overlapping surfaces as the top for the solid being created.
If only one surface is loaded Create Solid Above All Surfaces or Create Solid
Above Any Surface will behave the same and lead to the same result.
Note
If only one surface is loaded Create Solid Below All Surfaces or Create Solid
Below Any Surface will behave the same and lead to the same result.
Create Solid From

Polygons Creates a solid from a polygon. These polygons can be digitised I orimported
Create Solid Above Define a plane by typinginan X, Y, Z value. An upper surface is projected above
Plane this plane and a closed solid is triangulated.

Create Solid Below Define a plane by typinginan X, Y, Z value. An upper surface is projected below
Plane this plane and a closed solid is triangulated.

Joins two or more solids into the same layer. These solids can be intersecting, but
may be free standing.

Intersects solids. Returns the intersection of two or more solids. The result is that

part thatis common to all imported solids. Multiple solids may be imported here.

Outersects solids. Firstly, unions the inclusive solids together, then subtracts

Union Solids

Intersect Solids

Subtract Solids each excluding solid from the result. The result is that part of the Inclusive solids
that has had the Excluding solids removed from it.

Translate Solid or Typeinan X,Y, Z value to define the translation. Existing triangulated surface is

Surface translated to the new location.

Reduces the complexity of a solid. This functionality can be used to remove
shards left over after another operation (Example: Subtract Solids operation).
Input the solid with multiple solids, give a minimum acceptable volume, all the
minor solids with a volume below that minimum value will be removed.

Reduce Complexity

Upper Surface Anopen surfaceis created of the upper part of the input solid(s).

Lower Surface Anopen surfaceis created of the lower part of the input solid(s).

Clip Surface by ]
Polygon (Exclude Intersect a surface with a polygon(s). This can be digitised orimported
Outside) Exclude the outside.

Clip Surface by Qutersect a surface with a polygon(s). This can be digitised orimported

Polygon (Exclude
Inside) =

.Exclude the inside.
Append Surfaces Append surfaces to one anotherin the given order.

Creating Solids in the Solid Lab exercises

The following are some examples on how to use the Solid Lab tab functionality.

Many of these operations can be included in one Operations set to achieve a final outcome.
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Example, the following operations can be performed in one Operation Set to achieve a final phase
solid for Pit1 Stage 2.

Creating an Operations set

1. Add Operations Set and rename it to “Pit1_Stage?2”.

©)o e ¢

2. Add operation Clip Surface By Polygons (Exclude Outside).

[ Add Operation ~ @ YR, =] B ©
Operation Inputs ¥

I 1 (Clip Surface By Polygons (Exclude Qutside) |
Polygons 0 dosed polygons
Surface v
I (Mo Result Calculated) hd

3. Inthe Surfaces dropdown import topo from layers or files.

Clip Surface By Polygons (Exclude Inside) / Surface

R G

From File(s)

I From Layer(s)

N\

Choose Layers x
O | = 148~ | Tools ~
Name &

b = Dumps & % -
- \=y Surveys % 7/ -
EOM_Survey ¥ -
&P topo EFIRE

€y UpdatedSurveyPit3 oK v |
o oK

8 cancel || ok

4. Inthe Layers panel toggle to display all the Pit designs.
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o= % 43 - [Tooks -
Name ;@7 )
'Em @ %5 ~
@ pit1 s1 ® M-~
P pit1_s2 ® & 8-~
@ pit2 ® M-
@ pit3 ® &0~
» [ Dumps & K~
Bawes BB

5. Draw one closed polygon around them.

(1,241.65 | 2,199.18 | 791.95)

6. Press play button [.EI torunresults.
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7. Add operation Create Solid Below All Surfaces.

|5 Addoperaton ~ 1@ 4 ¢ P B ©
| ' Inputs 7

1 dosed polygon
| 2 Create Solid Below All Surfaces
Surfaces -
(No Result Calculated) -

8. Importsurfaces “pit1_s1”and “Output From Operation #1".

Create Solid Below All Surfaces / Surfaces

@Addlrputv@ 'SIE”,

MName

#1

9. Addoperation Create Solid Above All Surfaces.
10. Import surface “pit1_s2".

1 dosed polygon

Below All Surfaces
Surfaces
Result

3 Create Solid Above All Surfaces I

, #1

3 Surfaces
(No Result Calculated)

Page 33 of 75



micromine
alastri

11. Intersect the results of Steps 2 and 3 (#2, #3).

|G Addoperaton -] @ 4|9 P B ©

1

Operation Inputs

Clip Surface By Polygons (Exclude Outside)
Polygons 1 dosed polygon
Surface

Result

Create Solid Below All Surfaces

Surfaces pitl_s1, #1
Result

{reate Solid Above All Surfaces

Surfaces

(No Result Calculated)

«

Intersect Solids

Solids #2, 33
(No Result Calculated)

12. Reduce the Complexity for the result of step 4 (#4) and run all operations.

¢ Addoperaton ~| | |4 ¥ B O
Operation Inputs _L}‘ J
1 Clip Surface By Polygons (Exclude Outside)
Polygons 1 dosed polygon
Surface t -
Result v
2 | Create Solid Below All Surfaces
Surfaces pitl_s1, #1 -
Result - v
3 ate Solid Above All Surfaces
urfaces 2 v
- -
4 Int Solids
#2, #3 v
- -
I 5 Reduce Complexity |
2 Solid 724 -
Minimum Volume 100
Maximum Error 0.5
Pinch Tolerance 0.001
(No Result Calculated) B -
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13. Saveresulting solid to the Layers panel and review in the viewport.

9 addoperaton ~||@) (4] ¢ b B[O

EIRXC I e -

. A
Operation Inputs O | ® 43 ~ || Tools

1 Clip Surface By Polygons (Exclude Outside) 9 Name ® % 0
Polygons 1 dosed polygon Y 4 v & Pits ® &KV~
Surface ' @ pit1 st ® W~
Result - P pit1_s2 @& & -

2 Create Solid Below All Surfaces & nit2 ® &H-
@ pit3 @& o -

Surfaces  #1 Y

v | Dumps & ¢ -

Result - v, v & Surveys & & v

3 Create Solid Above All Surfaces 5 Solids X v
Surfaces 5 @ Pit1 Stage2 result | @® ! & v

Result

4 Intersect Solids
Solids #2, %3
Result

5 Reduce Complexity
Solid #4
Minimum Volume 100
Maximum Error 0.5
Pinch Tolerance 0.001

I » Result

1. Clipping a surface

Reduce the size of a surface file. Load smaller files into memory, excluding data not required.

1. Inthe Solid Operation Set panel add a new set.
a. Renameitto“Clipped Topo”.

O Q@ & ¥
olid Operation Set
1 Stage?

2. Press Add Operation button to add operation Clip Surface By Polygons (Exclude Outside).
a. Inthe Surfaces field import “topo” surface file (can be imported from file(s)/layer(s) or
dragged from the Layers panel).
Inthe Layers panel toggle to display all the pit designs.
Using the polygon tool draw a polygon around the area to keep.
Runthe operation by pressing the blue play sign.
a. Click on Result row to see the outcome in the viewport.
6. Clickonthe greenarrow iconto savethe resultto the Layers panel.
a. Renamethis new layerto “Clipped Topo”.

o w
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B om0l ¢ ¢ [B] 8 G e eQ @Bt vexFewis o 2 =
Operation Inputs e e A e b A A et || @) ||| ® 42 | |Tools ~
| |
1[(’hp Surface By Polygons (Exclude Outside) b \ || Name ® @ )
Polygons 1 dosed polygon X E + & PitDesigns ) ElZ R
Surface w ‘ . @ pit1_s1 @ |G v
= [Result ' @ pit1_s2 CAES R
| @ pit2 LIEE R4
@ pit3 @|% H -
1 || + [ Dump Designs & KU~
. @ dump1 ® &M~
P dump2 & g v
@ dump3 ® &M~
@ lg1 ® & E -~
& K~
P EOM_Survey X3 K
@ Cipped Topo ® o M-
Q 500 1000 1500 2000 2500 3000 3500
v S - S—
14599 195 1 0.200 me/1 _ MVIDIA Corperation MVIDIA GeForcs RIX 2070/PCIs/SSEZ | ORenGl v § @ NVIDIA S71.68
Grid Size for Surface Calculations: 5 3| (4,569.33]395.79 | 844.73

2. Intersecting Solids

1. Inthe Solid Operation Set panel add a new set.
a. Renameitto “Pitl_sT".
2. Press Add Operation button to add operation Create Solid Above All Surfaces.
a. Add“pitl_s1"surface to the Surfaces field:
i. Either by dragging and dropping it from the Layers panel, or
ii. Importing it from file(s) or from layer(s) through Add Input button dropdown.

Create Solid Above All Surfaces [ Surfaces

@ rame J© 4@

From File(s)

From Layer(s)

Output Frem Operation 1 %

¥ cancel J oK

3. Press Add Operation button to add operation Create Solid Below All Surfaces.
a. Add“Clipped Topo” surface to the Surfaces field:
i. Either by dragging and dropping it from the Layers panel, or
ii. Importing it from file(s) or from layer(s) through Add Input button dropdown.
4. Press Add Operation button to add operation Intersect Solids.
a. Clickinthe Solids field.
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b. Press Add Input button and select “Output from Operation #1" and “Output
from Operation #2".

Intersect Solids [ Solids

=)o « ¢

From File(s)
From Layer(s)

Output From Cperation #1
Output From Operation #2

N
8 cancel J Ok
c. Runtheoperation by pressing the blue play sign.
d. Clickon Resultrow to see the outcome in the viewport.
e. Clickonthe greenarrow iconto save the result to the Layers panel.
f.  Rename this new layer to “Pit1_stgl_solid".
Setup | Designer | Report | Solid Lab
0l © & o De :
Solid Operation Set Dasatar T =IE 18 + | | Tools ~
Cipped Topo 1 Create Solid Above All Surfaces — ® O

Result v ===l pit1_s1
2 Create Solid Below All Surfaces

slaw @

@ pit2

¢
%o g
g o s |3
g 33
a
T B

<
BB BRUBBEBE

Solids #1, #2

<

a

8

& ]
g

i34

~O GocdToo @ W]
[ Pt soe @ 7]

8|

00 Doration NVIDIA GeForce RTX 2070/PCle/SSEZ | OpenGl v4.6.0 NVIDIA 471 65

995 195 1 0.100 ms /1 WVIDIA Con
Grid Size for Surface Caluations: 55| (03711 1,27163 | 812,55

3. Clipping Solid by Polygon

1. Pressthe copyiconto copy the solid operation set for pit1_si.
a. Renamethe copyto "pitl_s2".
b. InCreate Solid Above All Surfaces field change the Surfaces selection to
"pit1_s2".
c. InCreate Solid Below All Surfaces change the Surfaces selection to "pit1_s1"
and the topography.
d. Runthe operations by pressing the blue play button.
e. Clickonthe greenarrow iconto save the resultto the Layers panel.
2. Click Add Operation and select "Create Solid From Polygons".
a. Pressthe up/downiconsto move the operationtothird place in the list.
b. Pressthe Draw Polygonicon and draw around the pit solid, excluding the batter
shards.
3. InlIntersect Solids field change the Solids selection to include "Output From Operation
#3".
a. Runtheoperations by pressing the blue play sign.
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b. Selectthe Resultrow to see theresult in the viewport.
c. Savetheresulttothe Layers panel.
d. Renamethis new layer to “Pit1_stg2_solid".

Setup | Designer | Report | Solid Lab

Q @ [ Addoperation ~||@)| & = i e QB #m *
] operation set Operation s : @ g% 42 ~||7o0s ~
|
D 1 Create Solid Above All Surfaces @ 1 | Name ® & O
Pit¥s1 [

Surfaces A i + [ Pit Designs B &~
» Piti_s2 Result - \ 4 ‘ i @ pitt_s1 B o -
1 [ E -

2 Create Solid Below All Surfaces ] 1 © pit 52 3 |
> 3 R

Surtaces ErrrTe— | o e 5cm
| pit3 ; -

=l B

Result [ | | 1 || + [ Dump Designs A7
3 Create Solid From Polygons & dump1 @ & W~
Polygons 1 dosed polygon P dump2 & & -
Result MR & dump3 @ & M-
! f @ 01 ® EE-
4 Intersect Solids i . o vy &0

= 557
topo v
» Result - QP EOM_Survey s & H-
& Cipped Topo - o~
e q _a) X h 4

P Pit1_stg2_sold ® &
W Pilssintersect | @ & L ”

23331ps 10,300 me/E _ NYIDIA Corporatial
Grid Size for Surface Calaistions: | 5 3| |(2,765,34 | 1,760.00 | 871.34)

This operation can be graphically explained as below:

Imported surfaces: Natural Surface =topo, Stage 1= piti_stgl_solid, Stage 2 = pit1_stg2_solid.

Natural surface
Stage 1
Stage 2
Ar h A
1 Stage 1
— ]
Stajel /<
Stage 2
Stage 2

\ / 1 y y Y
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4. Subtracting Solids

1. Inthe same Solid Operation Set “Pit1_s2".
a. Remove operation Create Solid From Polygons.
b. Inthe Create Solid Below All Surfaces operation field change the Surfaces
selection to include "Clipped Topo".
c. IntheIntersect Solids operation field change the Solids selection to include
"Output From Operation #1"and "Output From Operation #2".
d. Runthe operations by pressing blue play button.
e. Savetheresulttothe Layers panel.
2. Click Add Operation and select "Substract Solids".

a. IntheInclusive Solid field include "Output From Operation 3",
b. Inthe Exclusive Solid field add previously exported "Piti_stg_1_solid".
c. Runtheoperations by pressing the blue play button.
d. Selectthe Result row to see the result in the viewport.
e. Savetheresulttothe Layers panelas “Pit1_stg2_solid".
Setup | Designer | Report | SolidLab
QU e (& [:# AddOperaton ~||@ & - B Cil b @ QI # @ L
Solid Operation Set Operation Tnputs O (% Uf' Tools
Cipped Topo 1 Create Solid Above All Surfaces v f Name ® @ 0
Pit1_s1 curfaces @ - [ Pit Designs & &7
Resut = ‘J‘, @ o -t
2 Create Solid Below All Surfaces @ pit1 s2 o &
Surfaces ~ @ pit2 ]
Resut - oy B &
3 Intersect Solids & dump1 B g
Solids #1, 82 v P dump2 &
Result | K P dump3 @ o
4 Subtract Solids @ g1 g
Inclusive Soids #3 v IS Surveys
Excluding Solids B — : :(’::_Smev :

Io Result

% Clipped Topo

@ Fit1_stg2_solid

0 200 400 600 800 1000

9999 fps | 0.100 ms/t WV

TDIA Carporation
v | (3,222.36 | 847.35 | 778.98)

£ | OpenGL v4.6.0 NVIDIA 47163
Grid Size for Surface Calculations 5

Recommendation

When intersecting solids click on the row with the added solids. In the viewport, you will see two solids,
one above the other, as shown below. Thisis not a very clear example, as we cannot really see
intersecting area.
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[ Addoperaton ~ (@ (@ | @] b B

Operation Inputs

1 Create Solid Above All Surfaces
Surfaces
Result

2 Create Solid Below All Surfaces
Surfaces
Result
3 Intersect Solids

» Solids #1, #2
Result
4 Subtract Solids
Indusive Solids #3
Exduding Solids
Result

G QB #e

1
|
H Q 500 1000 1500 2000 2500
!
1

For better clarity, change the transparency of these solids.

[EY AuUUpETAuULl T | |G AR 4 ' B | e

(5 T S S R

Operation Inputs
Create Solid Above All Surfaces

-

Surfaces
Result
Create Solid Below All Surfaces
Surfaces P
/3 Result
3 Intersect Solids
Solids #1, #2
Result
Subtract Solids
Indusive Solids #3
Exduding Solids
Result

8]

ES

Grid Size for Surface Calculations:

© Hue (122
) sat 64.7
O right 100.0
Opacity: 192
# BESAFFSF
- Make Web-Safe
| 56%
N
tim
Sample: # cancel |7 oK

Rotate the resultant solids for better seeing the overlapping area. This area isthe result of the

intersection.
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v v
xp v o xp v o
A A

gl i T

Q 200 400 600 800 1000 1200 1400 0 200 400 600 800 1000

1200 1400

NVIDIA Corporation NVIDIA GeForce RTX 2070/PCle/SSE2 | OpenGL v4.6.0 NVIDIA 47168

5. Cleaning Solid from Remnant Blocks

As aresult of overlapping solids and surfaces, you can see a lot of remnant blocks around the resultant

solid that you wantto remove to facilitate further scheduling. Two basic methods to accomplish this
goal are outlined below.

Add a new operation - Reduce Complexity.

Add output from operation #3, which is the result of intersecting solids #1and #2.

In the Minimum Volume field specify the minimum volume, blocks smaller than which
will be excluded. In this example, 10 000 cubic meters.

4. Inthe Maximum Error field, set the triangulation error limit to 0.5.

5. Runthe operation and review the result.

W

[ addopenton - @ (& )

BeeqQ B #a 3 sdopesten ~| Q)] @ > 8o O+ ©Q B #@
Operaton s | . et ot ) s
1 Create Solid Above All Surfaces ] 7 1 Create Sokd Above All Surfaces 7
sutoces -\l >0 < Stbces = >l <
55 — - - -
2 cmzemumum,l Solids intersection result without Reducing Complexity |‘ e l Solids intersection result after Reducing Complexity A
Sutacs - Swtaces -
Result - \/ Result B -
3 [Intersect Solids. : 3 Intersect Solids
sads oo sods oo .
Result .- Result -
4 Reduce Complexity : 4 [Reduce Complexity
» Sold 3 v E N Sold. 3 |
Mommome 10000 \ Mo Vokme 10000
eommEre 05 Mosmmero 08
PonToeae 0001 PechToeance 0001
Resut -- Resul .-
. 100 00 30 a0 00 . ™ 20 30 o 500
G izefo Sufoce Coldatons: | S 5| (0.599.93 | 1,477.53 [ 80467 God e for Sufoce Colodotons: | 5 3| a0 00 | LATSOSITIGY s e e e

Compare results. In example on the right, you can see that there are fewer remnant blocks around
main solid.
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Method 2.

1. Add new operation - Create Solid From Polygons.

2. Draw a closed polygon around the solid.
3. Runthe operation and export the resultant polygon to the Layers panel.

4. Add a new operation - Intersect Solids.
5. Using the up and down arrows, place the Create Solid From Polygons operation in front

of it.
6. Add the outputs of operations #1, #2 and #3 to the Intersect Solids operation.

7. Runthe operation and review the result. If all steps are done correctly, you should get a
result like in the figure below - a solid with smoother boundaries, without extra remnant

artefacts, fitting the outlined polygon.

CEe=wo ¢/ ¢ » 8o 53 ¢ & B # =
Operation Inputs 7] T s e |
1 Create Solid Abave All Surfaces |
Surfaces
Result
2 Create Solid Below All Surfaces
Surfaces
Result

| 3 Create Solid From Polygons | |
'
Pﬂygons 1dosed palygon
Result hd
—
I 4 Intersect Solids I -
o
Solids #1, #2, #3 -

3 Result
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Designer tab

The Designer tab it's your main area to view, create, modify, manipulate and analyze Reserves (and

Dumps) levels solids and lines.
Setup Report | Solid Lab

The Designer tab consists of four areas, such as Tree Hierarchy (on the left), Viewport with toolbar,
Information Panel (below viewport) and Right Panel (on the right), each of those includes several
elements, tabs or fields.

Setup | Desgner | Report | Soid Lab

Pl e QB % m | @ B - [ G- B | | Dy n
Dot -|[ Ereoot - v Right Panel
Name | b
« ¥ Reserves ax <Pefimeter> )
- ® M v 1 -
- WP1

- W P01
e 800 Blasts / Digs
¥ 780

Tree Hierarchy |.

» e 700
- W P2

Display Type | Blasts -

Shading ]

» W s00
» W s
» W 880
»
W 860
» W 850
F 80
e 830
e am . [ 200 400 600800 1000 1200 1400
» o 810 e e e

, a0 . s tos 1 1,000 s NVIDIA Corparation NVIDIA GeForcs RTX 2070/ Cla/SSER | panct v

) 790 . || @820 127,541 895.27) ;
A Information Panel ®
o 780 R =

Category
~ Root

Construction Lines

Block Model
Blodks | B
Clip Height
Block Scale
Constraints )

Shading - @

Settings
Level Names
Sold Fropertes

Display | Layers  History

v' Depending onthe operations that are being run, different icons become available at a
top of viewport.

v'Allicons have tools tips, that appear when hovering mouse cursor over them.
Inthe tables below all toolbaricons are listed with description and hotkeys available.

Mouse controls

Selection Leftclick and drag

Pan Q’ Middle click and drag

Rotate fIE.f‘J Right click and drag

Zoom €1 Scrollwheel

Zoom Extents b4 Left click on the compass widget
Vertical

Exaggeration <CTRL>+ Scroll wheel
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Measurement and screenshot
Show/Hide grid H Toggle grid
] <Enter>-Toggle Including M -Pointin R It
Measure ) S] oggle Including Mouse-Po esu
Distances <Backspace> Remove Last Point
ol | | ) =

1% Resolution

2% Resolution .
Screenshot . [,\\.s Make a screenshot and choose a resolution

5% Resolution required

192001080

384002160

Compass
Plan View
Zoom Extents

Click onthe axis cones to snap to orthogonal views

6 Clickonthe grey cube to zoom to extents
' T

)
Night Mode v Clickonthe sunicon to toggle night mode and back

Extended Design tools

E -
Choice of Blast shapes generation from dropdown.
Generate Blast With Cumrent Bench [ Production, Trim, Ramp and Contour blasts shapes
Shapes can be generated for the entire project. Available
options depend on an element selected.
With Visible Fltches
Q.
With Current Bench Choice of designs to be deleted. Available options

Delete designs depend on an element selected

With Visible Flitches h

ab| »

Bulk Block

Rename With Selected Blasts Rename Blasts options

With Current Bench
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ikt = '.':'.‘

With Selected Blasts
I Strip Namer option to set Horizontal/Vertical Naming,

Strip Renamer Included Blast Types and Grid Orientation

With Visible Flitches

-

Automated Dig
Line Creation With Selected Blasts To create automated dig lines with selected
blasts/digs or current/visible flitches.

With Visible Flitches

Use the Scale Bar to estimate distances and scale in the viewport.

By pressing on alevelinthe Tree Hierarchy it will display in the viewport. You may also select the whole
reserve/mine/pit/stage/bench to display or selected solids using <CTRL> and <Shift> hotkeys.

Name

~ @7 Reserves ]
-8B M
- WPl
~ W P101
» " 800
» & 780
3 -~ O 760

= 760

» O 740

e Left-clickonany levelto display itinthe viewport. You can use the arrow keys on your
keyboard to quickly view and navigate between the level records.

e Expandthetree structuretothe desired level.

e Double-clickaleveltozoomtoitinthe viewport.

e Todisplay alist of blasts:
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o selectasolidinthe viewportand double-click on it (the bottom left panel will
also display Flitches on the selected Block, as shown in the figure above).

o Inthe Display panel onthe right, in the Display Type field, select "Blasts" (the
bottom left panel will display a list of the available Blasts on the selected Bench,
where you can also use the arrow keys to navigate through).

In a viewport you may review and work with results of operations and imported layers.

e Doubleclickonablastinthe viewport to enter edit mode, or
¢ Right-clickona blastand choose “Edit Selected Blast (.)" to edit the selected blast.

——

Edit Selected Blast (00103)

o Toexitthe edit mode, right-click anywhere in the viewport and choose “Stop Editing
Blast”, or click on any higher level in the tree (bench, stage, pit, mine).

Stop Editing Blast

r

e Boxselect group of blocks to select multiple and compare them in the Properties panel.

Inthe edit mode, right click on the selected block and choose the applicable option from its dropdown:

e “Extend selectiontoflitch (..)"-to extend the selected flitch over lower ones (used to
combine multiple flitches for one blast);

¢ “Donotextend selection” - to cancel flitch extension made.

Pick a benchinthelevel tree and cut up blasts as shown.
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e /n\/m\\\\ Blank Bench
// \\/
\ N\
X
\
\ |
\ /
.
%
\ P /
\\v L
Draw Line

1. Clickonthe drawicon —  ortype keyboard shortcut <D>.
2. Leftclick on one side of the bench, outside the boundary line.
3. Left click on the other side of the bench, outside the boundary line.

4, Press <ESC>to finish.

| Benchis cut into two volumes by the drawn line |

=

\ 1,071,527 BOM

1,342,361 BCM /'

4

v' During drawing, the <Backspace> key works as an Undo hotkey.

\
\____

Move Point

LF |
1. Click the point-move icon or type keyboard shortcut <F>.

2. Selectapointonaline.
3. Clickthe new point coordinates to move it there.
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Click a pgint to move it.

/ L_""‘-._\_\_
|
( 425,385 BCM
1,988,503 BCM |

Construction line must cross border (or other) lines to form
closed polygon

v' Construction lines must form a closed polygon into order to cut solids. This means they
must cross another line, or cross through the border polygon.

Offset Lines

1. Click the line-offseticon ortype keyboard shortcut <O>,
2. Select a line to offset (this may include the bench boundary polygon).

Offset line by fixed distances I Offset line by mouse control I\

1,807,203 BCM

Trim Lines

t

1. Clicktheline-trimicon or type keyboard shortcut <T>.
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2. Clickonalinetotrimitbacktothe nearestintersection.

278,776 BCM
32,531 BCM

/ Lines trimmed back SN
to the nearest Tl
Intersection 5,365 BOH

25,070 BCM |

44,886 BCM )
44,872 BCM

45,552 BCM

303,965 BCM

v The Trimtool may not detect an intersection where two closed polygons form an

. &S
adjacent corner. For these cases, use the Break tool to clear the segment.

Delete Lines

1. Box-selectalllinesin the viewport (they will become blue).

—
2. Pressthe <Delete> key or the delete icon
M & ¥ " Bl ] B

| Press <DEL> key to delete all lines |*

211,732 bem

v Evenifyou have solids selected, the <Delete> key will not delete them. The only way to
remove solids is by toggling the Force Exclude property in the Properties panel.
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v' Excluded blocks will be hatched according to the Hatch pattern setin the Setup >
Setting.

Blast Type Production -

Reserves Source BloddMode!

Undo/Redo

There are two ways to undo/redo changes made in the Designer tab:

1. Leftclickinthe 3D viewport to activate the area.
i Press <CTRL>+<Z>to undo the last change.
2. Openthe History panel in the bottom right of the application.
i.  Clickthroughthe history list to see different past states.

History o
Al
Initialize
Created Construction Line
Points Deleted
Created Construction Line
Points Deleted
Created Construction Line
Offsetted Construction Line
Points Deleted
Blast Generation
Blast Generation
» Changed Properties

anged Proper ties

s e
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Generate

Rapid Reserver contains tools for automatically generating blast masters on a single bench, or across

the entire mine.

Auto Grid Tool

Generate Blasts

Remove Existing Designs m

Generate Ramp Shots ] | Ramp Shot Settings

Ramp Shaot Minimum Angle (degrees) 4

Ak 4k

Ramp Shot Maximum Angle {degrees) 13

Generate Trim Shots /] | Trim Shot Settings

Trim Shot Length 100

Ak 4k

Trim Shot Width 30

Generate Internal Shots Y] | Internal Shots Settings

(@ Fitted Blasts () Straight Grid Cell Merge Propartion 0.35 7
Start ¥ (m) 2715.03231 =| StartY(m) 1461.53738 3
Size X (m) o | SizeY {m) 80 o
Bearing (%) 170.70301 : Create From Corner | | Create From Center
Bench Offset % (m) 05
Bench Offset Y (m) (1
Generate Contours m . e
Minimum Contour Area (mz) 100 o

8  cancel (g? oK

1. Inthe Level Tree, select the Stagel collection so that all benches in Stage 1are visible.
2. Pressthe Generate Blast Shapes button and select "With Visible Benches".

Setup | Designer | Report [ Solid Lab |

| Benches / uifts T e £Q B #@ @ & *"‘**":"rr::*ﬁ-iﬂ-@v!ﬁv

Eimport  ~| [fEport -
Name
+ ¥ Reserves
- 8 ML
- WP1
» ~ W P101
» O 780
» @0
» O 760
» W 750
» O 740
» O 730
» O 720
» O 710
» & 700 .
R 1T —
» o o g0 00 SO G0
» O 880

With Visible Benches

I

With Visible Flitches

870 1111 fps | 0.900 ms/t NVIDIA Corporation NVIDIA GeForce RTX 2070/PCle/SSE2 | OpenGL v4.6.0 NVIDIA 471.6

» O 860 (2,650.15 | 1,685. 16 | 745.00)

3. The Generate Blasts window will open.
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Tick Remove Existing Designs to clear existing linework.

Tick Generate Ramp Shots and enter the min/max ramp angle to detect.
Tick Generate Trim Shots and enter the trim shot length and width.

Tick Generate Internal Shots,

No ok

a. setthe gridtypeto "Fitted Blasts",
b. setthe Size Xand Size Y to the blast dimensions (80 x 80),
c. setthe Bearingto match the pit orientation (120°).

8. Tick Generate Contours and enter the minimum contour area.
9. Press OKto finish.

Use the top toolbar buttons to manually draw, move, join, and delete points and construction lines.

1 p®Q B #@ @Rl ¥ %% 757 28 2Eass 2P 8- 8 @4

|
(15X SRR T S, . SR ppsp—— T Y Sy PR Y
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1. Double click Minel\Pit1\Stagel to center it in the viewport.
a. Press Generate Blast Shapes button > “With Visible Benches”.
b. Inthe Generate Blasts window create Fitted Blasts at 30° bearing, as shown
below.

e ¢ Q B # @ @

I
1
I
|
I
2l
1
|
il
3
M
=
&
#
»

x — L
With Visible Benches

With Visible Flitches

Generate Ramp Shots ] Ramp Shot Settings
Ramp Shot Minmum Angle (degrees) 43
Ramp Shot Maximum Angle (degrees) 135

Generate Trim Shots -f Trim Shot Settings

Trim Shot Length 100
Trim Shot Width 30

I Generate Internal Shots w/I Internal Shots Settings
l (@) Fitted Blasts I _) Straight Grid Create From Corner Create From Center

Ak 4

1q T = e o = ||l rx so70rpcresssiz 1 openc va.6.0 nviDta 471
= =
1 3~ || Legend -
(_ Size X (m) 60 =| SizeY(m) 5 = Q =
A | Bearing ) 30 2] celmerge Proportion 035 * 2
Bench Offset X (m) | 0=
Bench Offset Y (m) | 03

Generate Contour Shots ||

#® cancel ||of ok

2. ForStagelbench 780, delete Production Blasts and manually create new blasts using
Create Polygon and Create Construction Line tools.
a. Remove existing internal blasts using Delete Segment tool (or highlight lines
and delete them).
b. Create Polygons and Construction lines.

D QI # @ &-z- % BTF BE FRER!
""""""""" Ao Uy
Create Polygon (P)

Q - Toggle Closed Palygon

Cur - Snap to 15° Angles

Shift - Snap to Integer Polar Distance

Al - Enter Coordinates Manually
Enteror F2 - Contnue

3. Repeat for Pitl/Stage2/Bench 830.
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View

Use the Display panel to control the viewport display.

Layers History

Labels

Labels may be used to show solid properties, reserves, and attributes at a glance.

e Togglethe eyeballicon ® |0 show and hide labels.
e Selectatexttodisplayinalabel from the Text dropdown or configure custom labels via

gearicon i
e Usethe colour, front and size selectors to alter the label display.

Labels

Labels | @&

Text |F v s
Back Color v Fore Color [N ~

Font Tahoma viSize| 8 3

-

Blasts/Digs

Blast solids and Dig solids may be displayed as 2D polygons or as 3D triangulations.

In the Blasts/Digs part of the Display panel you may choose type of solid to display (Blast or Dig) and set
its shading and opacity.

Note that different properties may be edited depending on whether Blast or Dig display is selected.
e Pressthe eyeballiconsto show and hide entities.

o Dragthe opacity slider to make polygons more or less opaque.
e Usethe Shading dropdown to colour the solids by their properties or contents.

Blasts / Digs
Polygons | ¢ | Opadty
Solids | @
Shading  <Blast Type> b 7:;}
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Construction Lines

Benches are divided into blasts by drawn construction lines. By pressing eyeball toggle, you can:

o toggle visibility of lines,
e displaylinesasfences.

Construction Lines

Lines | @ @5 | Extrusion

Block Model

Blast reserves are calculated by intersecting the 3D solid with the block model cells.

Press the eyeball icon to show or hide blocks.

Use the Clip Height slider to view the block model’s cross section.

Adjust blocks scale as desired.

Use the Constraints and Shading selectors to choose what to display and what to hide.

o Pressthegearicon & to open the Configuration window, where you can create
custom codes and formulas for constraints/shadings.

Block Model
Blodks | @

Clip Height
Block Scale
Congstraints | Fe greater 5! - uu

Shading Reserves: Parcel v {3
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Exercises

CREATING BLOCK MODEL CUSTOM SHADINGS

Simple shading example:

1. Pressthe gearicon next to the Shading dropdown. This opens the configuration dialog.

Block Model
Blocks | &

Clip Height

Block Scale

Constraints (none)

Shading Reserves: DryTonnes.AL v

Assign a colour to each parcel.
Press OKto accept.

NOo o R W

Configure Block Shadings

Pressthe blue plusicon to add a new shading set.
Rename the shading to "Materials".
Drop down the Shading Field and select “Parcel”.

Press the Create Entries button to populate all parcel names.

@ Y i} = E @ Simple | Complex

Mame
| Materials I

anges

o

Shading Field: IParceI

vI

Sort Ascending
Sort Descending

Value

Hg

mg
mw
Shg
Smg

Create Entries

Clear All Entries

Generate Gradient

(%]
o
5

4 4 4 4 4 44 A

iz

8 cancel [JoF

8. Inthe Block Model panel on the right, toggle eye icon to show blocks and from the

Shading dropdown select the blocks shading you have created -

custom shadings are shownin
normal black).

(Note that

,While standard shadings are shown in

OK

9. Select bench(es) from the tree on the left to display the viewport and review the result.
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10. Colours assigned for block shading can be seen in the Legend (bottom right, below the

viewport).

Setup | Designer | Report | Solid Lab
Lift 3

A

BeoE- E- e B

(=} Import

| Name

Complex shading example:

Press the gear icon next to the Shading dropdown. This opens the
Press the blue plusicon to add a new shading set.

Rename the shading to "Ranges".

Select the Complex tab to open the code editor.

Paste in one of the sample code snippets.

OEGENRENES

shown in the Errors panel and won't et you to proceed.

Labels | @
Text | Volume v 5
'+ Fore Color iT

Font | Tahoma

Back Color

v Size | 8 :
Blasts / Digs

Display Type Blasts
Polygons | @ | Opadty

@ | Opadty

Shading | Blast Type

Solids

Construction Lines
Lines | @ @ | Extrusion

Block Mode!

Blocks

Clip Height
Block Scale
- )

Constraints  (none)

Shading I aterials

configuration dialog.

Press the Test button to make sure your code is correct. Any errors found will be

Configure Block Shadings o | x
Qo /¢ S@@ [sw[low]
bisme S ndo | [ Redo)
Materials ————

» Ranges 1 )
2| using System;
3, using System.Collections.Generic;
4| using System.Drawing;
5. using System.Text;
6. using System.Ling;
7. using Alastri.RR.Ui;
8 using Alastri.RR.Service;
1 public class CustomBlockShading : IBlockShading
LI
1 public Color GetColor(BlockContext context)
13| {
14 double fe = context.N("DryTonnes.FE");
15
16 if(fe > 60) return Color.FromArgh(255,0,138); //pink
17 else if(fe > 55) return Color.Red;
18 else if(fe > 52) return Color.Orange;
19 else return Color.WhiteSmoke,
20 }
21

< >
IL\ne 19: ; expected I
Formulas | Errors
® cnel | f oK

7. Fixany errors detected, run test again and press OK to accept.
8. Review the resultant shadingin the viewport.
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!
%ﬁ :
o S F

A T

v/ Shading high Fe (pink and blue) vs. high Al (grey and blue).

SHADINGS CODES EXAMPLES

Simple Grade Shading

1 using System;

2. using System.Collections.Generic;

3. using System.Drawing;

4. using System.Text;

5. using System.LingQ;

6. using Alastri.RR.Ui;

7. using Alastri.RR.Service;

8.

9. public class CustomBlockShading: IBlockShading

10. |

1. public Color GetColor(BlockContext context)

12. {

13. double fe =contextN("DryTonnes.FE");

14.

15. if(fe >60) return Color.FromArgb(255,0,138); //pink
16. elseif(fe>58) return Color.Red;

17. elseif(fe>56) return Color.Orange;
18. else return Color.WhiteSmoke;

19. B

Multi-Variable Shading

1 using System;

2 using System.Collections.Generic;
3 using System.Drawing;

4 using System.Text;

5. using System.Ling;

6 using Alastri;

7 using Alastri.RR.Ui;

8 using Alastri.RR.Service;

9.

10.  public class CustomBlockShading: IBlockShading
" |

12. Color el_low_e2_low = ColorMagenta;

13. Color e1_high_e2_low = Color.DeepSkyBlue;

14. Color el_low_e2_high = Color.Yellow;

15. Color el_high_e2_high = Color.White;

16.

17. double elementi_Min = 0;

18. double elementi_Max =12;

19. double element2_Min =1.5;
20. double element2_Max =3;

21.

22. public Color GetColor(BlockContext context)

23. {

24, double elementt=contextN("Head_Tonnes.SiO2",
25. double element?2 = contextN("Head_Tonnes.Al203");
26.

27. double x =element2 - element2_Min;

28. x =Math.Max(0, x);

29. x =Math.Min(x, element2_Max - element2_Min);
30.

31. doubley =elementl-elementi_Min;
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y =Math.Max(0, y);
y = Math.Min(y, elementi_Max - elementi_Min);

ColortopLerp = Lerp(el_low_e2_high, el_high_e2_high, x/ (element2_Max - element2_Min)),
Color lowLerp = Lerp(el_low_e2_low, e1_high_e2_low, x/(element2_Max - element2_Min));
Colorlerp= Lerp(lowLerp, topLerp, vy/(elementl_Max-elementi_Min));

returnlerp;

public Color Lerp(Color ong, Color two, double pct)

return Color.FromArgb((int)(one.R + pct* (two.R-one.R)),
(int)(one.G + pct * (two.G-one.G)) ,
(int)(one.B + pct * (two.B-one.B)) );

CREATING BLOCK MODEL CUSTOM CONSTRAINT

Constraints may be used to hide parts of the block model based on some criteria, such as material

type or grade threshold.
1. Pressthe gearicon nextto the Constraint dropdown. This opens the configuration
dialog.
Block Model
Blocks | @

Clip Height

Block Scale
IConstlaints (none) v g2
Shading v &

2. Clickthe blue plusicon to add a new constraint.
3. Renamethe labelto"Fe and Al".
4. Paste the sample formulainto the code editor.

Filter by Fe and Al

1.

using System;

using System.Collections.Generic;
using System.Text;

using System.Ling;

using Alastri.RR.Ui;

using Alastri.RR.Service;

public class CustomBlockConstraint: IBlockConstraint

public bool IsVisible(BlockContext context)

if (contextN("DryTonnes.FE") >=57.5 && contextN("DryTonnes.AL") >=1.0)
{

returntrue;

return false;

5. Pressthe Test button to make sure your code is correct. Any errors found will be
shown in the Errors panel and won'tlet you to proceed.
6. Fixanyerrorsdetected, runtest again and press OKto accept.
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Configure Constraints o[ x

@o ¢ ¢ =aa

<aUndo | |#> Redo

Name -
Only HE 1 us‘lng System; ) .
2: using System.Collections.Generic;
[ Feandal | i R
3i using System.Text;
Aland 5i 4: using System.Ling;
Fe 5i using Alastri.RR.Ui;
Fe lessequals 55 6: using Alastri.RR.Service;
Fe greater 55 Y4

public class CustomBlockConstraint : IBlockConstraint
{
public bool IsVisible(BlockContext context)
1
if (context.N("DryTonnes.FE") »= 57.5 && context.N("DryTonnes.AL") »= 1.@)
{
return true;

}

return false;

No errors detected
Formulas

® cancel [[of ok

7. Inthe Block Model panel on the right, toggle eye icon to show blocks and from the
Constraint dropdown select the constraint you have created - (Note that
custom shadings are shownin ,While standard shadings are shownin
normal black).

8. Selectbench(es)from the tree on the left to display the viewport and review the result.

9. Coloursassigned for block shading can be seenin the Legend (bottom right, below the
viewport).

Labels @
» 720
» O 710
» & 70
P102

Text ]
i
1| Back Color v Fore Color [ ~
i

Font Tahoma vSel 83

» 8%
-~ O 830
B s
» O 8n
» O 860
» 850
» 80
(- 5
;

» O 810

i

3 Blasts / Digs

i/ Display Type Blasts

Polygons @ | Opadty
Soids @ | Opadty

» & 500
» 70
» O 780
PO
» W 760

Blasts
» 00100

Create other constraints (such as “Only HG", “Fe greater 55", “Only Fe") using codes listed below, or
practice writing your own.

Show only HG

. using System;

using System.Collections.Generic;
using System.Text;

using System.Ling;

using Alastri.RR.Ui;

using Alastri.RR.Service;

—

Nook~wn
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8. public class CustomBlockConstraint: IBlockConstraint
9. {
10. public bool IsVisible(BlockContext context)

{
12. if (contextN("DryTonnes.FE") >=57.5 && contextN("DryTonnes.AL") >=1.0)
{

14. returntrue;
15. }

16. return false;

17.

18. }

19.

20. }

Filter by Fe

1 using System;

2 using System.Collections.Generic;

3 using System.Text;

4 using System.LingQ;

5 using Alastri.RR.Ui;

6 using Alastri.RR.Service;

7

8 public class CustomBlockConstraint: IBlockConstraint
9

10 public bool IsVisible(BlockContext context)
1. {

12. if (contextN("DryTonnes.FE") >=57.5)
13 {

14 returntrue;
15 }

16 return false;

17

18 }

19.

20. }

Fe greater 55

1 using System;

2 using System.Collections.Generic;
3 using System.Text;

4, using System.LingQ;

5. using Alastri.RR.Ui;

6 using Alastri.RR.Service;

-

8

public class CustomBlockConstraint: IBlockConstraint
{
10. public bool IsVisible(BlockContext context)
1. {
12. if (contextN("DryTonnes.Fe") > 55)
{

14. returntrue;

16. return false;
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Layers

Triangulations and linework may be loaded in the Layers panel. This may be useful for visualising the
pit extents, topography and design lines.

Layers R
FIEIE:
.Name 'd@ - '
~ (= Pits ® 5 R
@ pit1_s1 ® G5 M-
@ pit1_s2 @ G K-
@ pit2 ® 5 W~
@ pit3 @ G & v
» = Dumps & S K~
~ |y Surveys ® & -
@P EOM_Survey ® 5 v
@ topo @ G & v
@ UpdatedSurveyPit3 @ 3 &F v
P Clipped Topo @ 5 T~
v [ Solids ® 5 R~
Display | Layers ‘History
Layers panel tools
.@. Add Layer
% Remove Layer
L@ Create Folder
L Sort Layers
Toals - Tools
@ Visibility Toggle
G Snap To Surface
& Show Edges on Triangulations / OverDraw on Polylines/Points
B Color Selector

The Layers panel supports drag and drop of triangulation files directly from Windows Explorer.
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Inspect
The Properties panel displays the properties and attributes of the current solid selection.

Properties o

Category
~ Root

Force Exdude
Settings ; -7 _ﬂ
Level Names Bla_st T\;'pe

Bench 10 i 10
Blast (multiple values) 46 00111 00300

Solid Properties ~
Density 0 0 0 0
Bore 0 hatlil * 0 * 0 -
PctDrilled OFF - OFF ~ OFF ~ OFF v

Metrics s

wall Control A

Reserves Error List

Force Exclude Excludes unwanted solids from the reserves
Too Small Excludes smaller solids from being displayed
Is Locked Prevents a solid from being edited

Blast Types Trim / Contour/Ramp/FreeDig/Production

Reserves Source Block Model/ Grade Control

Reserves/Mine/Pit/Stage/Bench Level address of the solid

Level Names

Blast (Solid) Unigue blastname

Solid Properties User specified values in Phase/Blast/Dig Properties setup steps
Metrics

Solid Volume Solid volume (m3)

Surface Area Solid surface area (m?2)

Perimeter Solid perimeter (m)

Count Solid count

Wall Control

User specified partial perimeters in Wall Controls setup step

Wall, Scaling, Presplit (example, wall, scaling, presplit)
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Reporting

Create report to checktonnes and grade by Stage and Parcel.

1. Navigate to the Report tab > Reports.

Setup | Designer Solid Lab

Reports | Plots

2. Press Add Report button > Blast Pivot.
3. Name it “Reserves Check”.
4. Drag fields between Filter, Column, Row and Data areas:
a. “Blast Type” headertothe Column Area,
b. “Namel”"and “Parcel” headersto the Row Area,
c. “Reserves.WetTonnes” and “Reserves.DryTonnes” headers to the Data Area.

Setup | Designer | Report | SolidLab

Reports | Plots

[l Collapse Name I Pivot I Chart VALUE: 128551069, 147833 [ Configure Format | (&&] Copy Image

l » &) Reserves Check l
Name.7

=5 Add Folder
=% Add Report - Reserves.DryTonnes BlastType N8
— - Reserves
E§ Blast Pivot Name..+ | Parcel + | Production Ramp Trim Grand Total
’ DryTonnes
B DigPivot N - Backfils  (soid info) 0 0
WetTonnes
B Soid Grid Backfils Total 0 0
==:] ‘
- - Dumgs (sold info) 0 0 Reserves.Volume
8 Parcel Grid Dumps Total 0 0 Reserves.Wet Tonnes
B8 Solid Table ~ Reserves  (solid info) 0 0 0 0 WallControl
Parcel Table Hg 48,605,827 543,446 5,846,292 54,995,566 Drag fields between areas befow:
;;j CSV Merger (] 6,044,893 81,247 974,727 7,100,867 Y Fiter Area 222 Colgmn Area
mg 3,835,388 70,844 642,428 4,548,659
() Export Selected Hosthpe
mw 5,725,043 86,465 982,956 6,794,463
ﬁ Export Manager ~ Shg 5,285,602 63,558 582,478 5,931,638
Smg 390,649 6,380 69,728 466,757
H export Templates " 3 =
W 52,236,116 2,082,625 28,417,861 82,736,602 R Aren T Datd Area
[ Import Template Reserves Total 122,123,517 2,934,565 37,516,471 162,574,552
Name. 1 Reserves.DryT
Grand Total 122,123,517 2,934,565 37,516,471 162,574,552 Parcel ;
arc

Defer Layout Update

Chart Options

Chart Type:
Bar

Show Labels

Show Column as Series

5. Openthe Chart tab to view the chart.
a. Map otherfields, if required,
b. Change Charttype, andtoggle labels and columns display options in the Chart
Options panel on the bottom right.
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[ pwvot [ chart | VALUE: 128551069, 147838 ({3 Configure Format | (] Copy Image
50000000 Il Backfills | (solid info) | Resen * B Blast a
Il Backfills | (solid info) | Reser » B Name
55000000 Bl Dumps |(solid info)| Reserve » Bm Reserves
Il Dumps | (solid info)| Reserve » Bn WalControl
50000000 Bl Reserves | (solid info) | Reser .
Bl Reserves | (solid info) | Reser &5 Bench
Il Reserves |Hg |Reserves.Dry " == Count
45000000 Bl Reserves | Hg | Reserves.Wet BB Flitch
= Reserves |Ig |Reserves.Dry T == Full Name -
Reserves | Ig| Reserves.wet 1
40000000 Bl Reserves | mg|Reserves.Dry Drag fields between areas below:
Il Reserves | mg | Reserves.Wet Y Filter Area £2E Column Area
35000000 I Reserves | mw |Reserves.Dry BlastType
Il Reserves | mw | Reserves. Wel
30000000 [ Reserves | Shg| Reserves.Dry
[l Reserves | Shg | Reserves.We
] Reserves | Smg|Reserves.Dn . -
25000000 ] Reserves | Smg | Reserves We e e
Reserves | w |Reserves.Dry T Name. 1 Reserves.DryT...
20000000 [ Reserves | w|Reserves.Wet T Parcel Reserves. Wet...
(Data)
15000000 L
=T Defer Layout te Update
[ Defes Upda
10000000 Chart Options
Chart Type:
5000000 || Il[ll o =
0 Il al - £
Production Trim [CJ show Column as series "

1. Select a bench, lift or flitch from the tree on the left and its blocks will be displayed in the
main viewport.

2. Pressthe gearicon and configure Custom Template with data you wish to display in the
plot report.

3. Select a shading and label you wish to apply to the selected element by choosing them
from Shadings and Label dropdowns accordingly.

setup | Designer | Report | solid Lab
= |

Template: Template 1 vléﬁ} |

Ishadlng: Grade - l\
[Gaamme -] [\ Reserves/M1/P1/P101/760/760

= CXIRXRRD
g Reserves N Tempiates Settings ‘.:’:’:.:’:’
- WM oo 4% B= Style Regular B QQQ.Q
- Wei 7 Legends -
- W P01 R ::::me i gsnuw Legends ¥4
. Font Verdana -
M- = .
- e m Style Regular -
Shaw Scale Scale -
» La= "
= s Draw Layers Over Blocks [m] ‘ ‘
it i X K
B b ) ‘@:2:: %0
N b Block Model ~
- Emm > Show Block Model % ,":’:.:’ ’..
Sm= i e DREARSES X2
- e e 2 Shading Resarves: bryromesre [ "’."“.”. ".
Bmw > Constraint Materids .’.’.‘."” .0’0‘
- & 0 > Solid Alpha Ranges 590,900, K
& | P = RRELHKS %
- wlrm Reserves: DryTomnes.FE N o » ’.0.’..”"..
) OSSO SN S S Reserves: ryTomes. St 0009,
= 890 Reserves: WetTonnes. Moisture

- & a0
=EE
- s

- e 860
=IE=

~ & 850
=IEE

L

= IED) hd

Information on other reporting options and report types available in this tab see in the RR. Report tab
section in the main documentation space.
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Import and Export

v' If blasts designs have been created outside Rapid Reserver, they can be imported into

the project.

v' Orblasts created by Rapid Reserver can be exported and used in another software for

drilland blast design.

Import

Import Blast Polygons, as follows:

1. Go to Designer tab > Benches/Lifts panel > Import button > “Into Project” option > “Named

Blast Polygons”.

2. Review the mapping template to choose which files to be imported into which
benches/flitches, and how the blasts/digs will be named.

a. Theblastsare automatically inserted into the correct location.
b. Ifblastsare not mapped, they can be dragged into the correct location.

Import Named Blast Polygons

Import Named Polygons

Select mapping tempate to choose which files willbe imported into which benchesfitches, and how the blasts/digs wil be named.

Templates Delimiters
@0 & Vv Filename Delimiters \e.®
Name Layer Name Delimiters | \_/~."
» New Template
e femp File Mappings
Field Name

b Level Name: Mine
Level Name: Pit
Level Name: Stage
Level Name: Bench

Data Mappings
Field Name

» Property: Density
Property: PetDriled
Property: Blast Type
Level Name: Biast

Preview
[Fiename]  [Flename. 1]
Reserves_.. Reserves
Reserves_.  Reserves
Reserves_.. Reserves
Reserves_.. Reserves
Reserves_..  Reserves
Reserves_.. Reserves
Reserves_  Reserves

Mine
Mine
Mine
Mine
Mine
Mine
Mine

Name Delimiters

Description Delimiters

e
U

—
[Filename.3] | [Flename. 4]

Stagel
Stagel
Stagel
Stagel
Stagel
Stagel
stagel

Level Collection Reserves

Expand Into Gaps

[Fiename. 5]

1
6
8
10
12
14
15

[Fiename.5] |[LayerName]
| hlasi

ReservesM.
ReservesM.
Reserves/M.
ReservesM.
ReservesM.
ReservesM.
ReservesM.
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[Layerhiame
Reserves
Reserves
Reserves
Reserves
Reserves
Reserves
Reserves

Input Name

[Flename.2]

| [Flename. 3] |
# Fiename. 4]
[Flename. 5]

Input Name
[Desariptior]
[Name.2)

(Name]
([Fiename.e] |

Layerhiame. .| [Layeriiame.

Mine
Mine
Mine
Mine
Mine
Mine
Mine

Pit1
Pit1
Pit1
Pit1
Pit1
Pit1
Fit1

\\

LLaye

Stagel
Stage1
Stagel
Stagel
Stage1
Stagel
Stagel

la
700
700
700
700
700
700
700

\\

P —

[Name] [Name. 1]
Reserves Mine/Pitl/Stage /7001 Reserves
Reserves Mine/Pit1/Stage1/700/6  Reserves
Reserves/Ming/Pit/Stage1/700/8  Reserves
10 ReservesMing/Fit1/Stage1/700/10  Reserves
12 Reserves/Mine/Pit1/Stage1/700/12  Reserves
14 ReservesMine/Pitl/Stage1/700/14  Reserves
15 Reserves/Ming/Pit1/Stage1/700/15  Reserves

@ o e

MNext >

[Name.2]
Mine ~
Mine
Mine
Mine
Mine
Mine
Mne

Cancel
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If the previous form is filled out correctly, the next form should be able to identify the correct file to
map to each bench due to activating the Map to Files option. If the files are not mapped to the correct
bench, you can delete the auto mapping and drag and drop the correct file to the correct bench.

Import Named Blast Polygons o
Map Files to Benches/Flitches.
Choose which files are imported into which bench/fitch
Name Mapped Layers Data Layer
« ¥ Reserves @ - | |» OReserves_Mine_Pit1_Stage1_700_1/Reserves/Mine/Pit1/Stage1/700 ~
+ B Mine (] © Reserves_Mine_Pit1_Stage1_700_6/Reserves/Mine/Pit1/Stage 1/700
~ W Pit1 o © Reserves_Mine_Pit1_Stage1_700_8/Reserves/Mine/Pit1/Stage1/700
+ WP Stagel [} @ Reserves_Mine_Pit1_Stage1_700_10/Reserves/Mine /Pit1/Stage 1/70
w 790 Reserves_Mine_Pit1_Stage1_790_1/Reserves/Mine/Pit1/Stage1/790/1; Reserve... & @ Reserves_Mine_Pit1_Stage1_700_12/Reserves/Mine/Pit1/Stage 1/70
& 780 Reserves_Mine_Pit1_Stage1_780_5/Reserves/Mine/Pit1/Stage 1/780/5; Reserve © Reserves_Mine_Pit1_Stage1_700_14/Reserves/Mine/Pit1/Stage1/70
w Reserves_Mine_Pit1_Stage1_770_1/ReservesMine/Pit1/Stage1/770/1; Reserve © Reserves_Mine_Pit1_Stage1_700_15/Reserves/Mine/Pit1/Stage 1/70
w 760 Reserves_Mne_Pit1_Stage1_760_1/Reserves/Mine/Pit1/Stage 1/760/1; Reserve © Reserves_Mne_Pit1_Stage1_700_16/Reserves/Mine/Pit1/Stage1/70
& 750 Reserves_Mine_Pit1_Stage1_750_1/Reserves/Mine/Pit1/Stage 1/750/1; Reserve... @ © Reserves_Mne_Pit1_Stage1_700_22/Reserves/Mine Pit1/Stage1/70
& 740 Reserves_Mne_Pit1_Stage1_740_1/Reserves/Mine/Pit1/Stage1/740/1; Reserve... @ © Reserves_Mne_Pit1_Stage1_700_23Reserves/Mine/Pit1/Stage1/70
& 730 Reserves_Mne_Pit1_Stage1_730_4/Reserves/Mine Pit1/Stage 1/730/4; Reserve © Reserves_Mne_Pit1_Stage1_700_26/Reserves/Mine/Pit1/Stage1/70
T 720 Reserves_Mne_Pit1_Stage1_720_1/Reserves/Mine/Pit1/Stage1/720/1; Reserve © Reserves_Mne_Pit1_Stage1_700_27/Reserves/Mine/Pit1/Stage1/70
w70 Reserves_Mine_Pit1_Stage1_710_1/Reserves/Mine/Pit1/Stage1/710/1; Reserve © Reserves_Mne_Pit1_Stage1_700_33/Reserves/Mine/Pit1/Stage 1/70
& 700 Reserves_Mne_Pit1_Stage1_700_1/Reserves/Mine/Pit1/Stage 1/700/1; Reserve... & © Reserves_Mne_Pit1_Stage1_700_34/Reserves/Mine/Pit1/Stage /70
~ WP Stage2 © Reserves_Mine_Pit1_Stage1_700_37/Reserves/Mine/Pit1/Stage 1/70
& 50 Reserves_Mne_Pit1_Stage2_890_1/Reserves/Mine/Pit1/Stage2/890/1 © Reserves_Mne_Pit1_Stage1_700_38/Reserves/Mine/Pit1/Stage 1/70
" 830 Reserves_Mine_Pit1_Stage2_880_1/Reserves/Mine/Pit1/Stage2/880/1 @ Reserves_Mine_Pit1_Stage1_700_42/Reserves/Mine/Pit1/Stage1/70
w870 Reserves_Mine_Pit1_Stage2_870_1/ReservesMine/Pit1/Stage2/870/1 © Reserves_Mine_Pit1_Stage1_700_45/Reserves/Mine Pit1/Stage1/70
© 860 Reserves_Mine_Pit1_Stage2_860_1/Reserves/Mine/Pit1/Stage2/860/1 x © Reserves_Mine_Pit1_Stage1_700_47/Reserves/Mine/Pit1/Stage 1/70
W 850 Reserves_Mine_Pit1_Stage2_850_1/ReservesMine/Pit1/Stage2/850/1 [ © Reserves_Mine_Pit1_Stage1_710_1/Reserves/Mine/Pit1/Stage1/710
& 840 Reserves_Mne_Pit1_Stage2_840_1/Reserves/Mine/Pit1/Stage2/840/1 (] © Reserves_Mine_Pit1_Stagel_710_S/Reserves/Mine Pit1/Stage 1/710
w 830 Reserves_Mine_Pit1_Stage2_830_1/ReservesMine /Pit1/Stage2/830/1; Reserve .. & © Reserves_Mine_Pit1_Stage1_710_7/Reserves/Mine/Pit1/Stage 1/710
& 520 Reserves_Mine_Pit1_Stage2_820_1/Reserves/Mne/Pit1/Stage2/820/1 [ © Reserves_Mne_Pit1_Stage1_710_11/Reserves/Mine/Pit1/Stage1/71
& 810 Reserves_Mne_Pit1_Stage2_810_1/ReservesMne/Pit1/Stage2/810/1 © Reserves_Mine_Pit1_Stage1_710_12/Reserves/Mine/Pit1/Stage 1/71
& 800 Reserves_Mne_Pit1_Stage2_800_1/Reserves/Mne/Pit1/Stage2/800/1 ] © Reserves_Mne_Pit1_Stage1_710_15/Reserves/Mine/Pit1/Stage1/71
& 70 Reserves_Mne_Pit1_Stage2_790_1/Reserves/Mine/Pit1/Stage2/790/1 © Reserves_Mne_Pit1_Stage1_710_17/Reserves/Mine/Pit1/Stage1/71
& 780 Reserves_Me_Pit1_Stage2_780_1/Reserves/Mine/Pit1/Stage2/780/1 © Reserves_Mne_Pit1_Stage1_710_20/Reserves/Mine/Pit1/Stage1/71
o m Reserves_Mne_Pit1_Stage2_770_1/Reserves/Mne/Pit1/Stage2/770/1 i © Reserves_Mne_Pit1_Stage1_710_21/Reserves/Mine/Pit1/Stage1/71
<Back Finish Cancel

Xpo

Export reserves model to AlastriInventory Model files (“.invmodel”) for further import into Haul Infinity
or Tactical Scheduler.

esigner | Report | SoidLab
Benches / Lifts | £ Q | # @ @ | . Ve % BTN ISERETS SR N B B B - B|Dsehy
i N\ ¥
e From Project » Alastsi Inventory Model \ 7 |
b v ¥ Reserves - Blast Constructigg Lige: \ P T
- B rine . Dig Constructiof B Seve As X
- WP Fitt -
» WP Stage1 . Reserves to Fol 4 7 > ThisPC > Desktop » Newfolder v © O SearchNewfolder
» WP Stage2 - Reserves Archiv
- W Pit2 . Named Blast P Organize v New folder (7]
+ WP Stage - ~
W Fit3 : Named Dig Pol [ Documents # ~  Mame Date modified Type Size
» WP Stage - Named Blast So =] Pictures * | RR_InventoryModel_Demo.invModel 12/10/2021 11:20 AM INVMODEL File
~ A& Dumps Mamed Dig Soli Mew folder
+ & Dumpl Reserves Models
+ M Dump2 5 N
+ Do creenshots
&gt Training to Kazal
@ OneDrive v
File name: | RR_InventoryModel_Demo.invMadel -
Savees type: Alastri Inventory Files (*invModel) v
Alastri Inventory Model f‘—
ot : Save l Cancel
l RR_InventoryModel_Demo.invModel =]
2
=] moements n
T T— ume block was found (Reserves/Mine/Pit1/Stage 1/790/27) - 60m® -
B e ume block was found (ReservesMine/Pit1/Stage 1/790/27/730/1) - 60m?
\ W i sliver was found (Reserves,Mine/Pit1/Stage 1/780/105): 0.567m
¥ W P2 sliver was found (ReservesMine /Pit1/Stage 1/780/105/780/1): 0.567m
+ O W pits lume block was found (Reserves/Mine/Pit1/Stage 1/780/65) - 3m*
+ 7 & Dumps lume block was found (Reserves/Mine/Pit1/Stage 1/780/81) - 1m*
lume block was found (Reserves/Mine/Pit1/Stage 1/780/88) - 7m?
ume block was found (Reser 1/5taae 1/780/82) - 3me ~f] «
|
L ® cncel |[|of o Display

Information on other import and export options see in the RR. Imports and Exports section in the main
documentation space.
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Exercise: configuring and exporting plot with custom labels, shading and constraint

Complete the following step to get an exported plot report as shown below:

Reserves/M1/P1/P101/720/720
Block Model

T 1
y X iy 1
f - o~ Emg
B mw
| |shg

W smg
{0

| e
| 20,588 fom

nnnnnnnn

1. Navigate to the main Report tab > Plots tab and extend the tree structure to the
bench required. Here - 720. In the plot viewport you'll see only a grid and bench
contour. To display relevant information, you will be prompted to configure a
template and select preconfigured shadings and labels.

Setup | Designer Solid Lab

Template: Template 1 v s
Shading: (none) v

Label: (none) v

Name
» $7 Reserves “
- W M1
- WPL
- W P101
» & 780
» W70
v & 760
v W 750
» W 740
» B 730
- B 720
[> B 720 ]
Y O 710
» W 700
» W P102
» W P2
» W PR3
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2. Locate the Template field and press the gearicon to the right

3. Create newtemplate and rename it to “Custom with Block Model”, for example.
4. Populate the settings required:

DaooTw

Change Labels display Size to 10 and Style to Bold.

Change Legend Size to 15.

Flag Draw Layers Over Blocks checkbox.

Flag Clip to Silhouette checkbox.

From the Shading dropdown select preconfigured template Materials
(If not preconfigured, see instruction in Designer tab > View > Exercises
> Creating Block Model Custom Shading section above).

From the Constraint dropdown select preconfigured template Fe and
Al (If not preconfigured, see instruction in Designer tab > View >
Exercises > Creating Block Model Custom Constraint section above).
Make sure checkboxes to show title, labels, legends, block model and
grid lines are flagged.

Make any additional changes to sizes, fonts, and styles of any of other
plot elements, to suit your preferences.

Plot Settings

Templates

[Clo ¢ ¢ B

Name

| » custom with Block Mode!

Template 1

Show Title
Font Verdana -
Size 28

Bold

Show Labels

Font Verdana -
Size 10
Style BOE

Legends ~
Show Legends @
Font Verdana v

| siz= 15 |
Style Regular -

Show Scale
Expand Distance (m) 0
Block Shading Opacity [0.1 - 1.0] 1
Draw Lavers Over Blocks

Width

Height 1080

Block Model ~
Show Block Model
Show Grid Lines
Clip to S-irhouerte
Shading Materials -
Constraint Fe and Al -

&N LN

Solid Alpha 1
% oo
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5. Press OKand review the plot. You may notice that some relevant information is
lacking, such as labels and blasts shading. These must be preconfigured in the

o
Designer tab.
Reports | Plots
[ Template: Custom with Block Model L |
Shading: (none) . \\ Reserves/M1/P1/P101/720/720 .ﬂr Model
1 i
Labek: (none) \ - \ . e
v\ B
—/_ [lsha
Go to Designer tab to configure / =w
Labels and Blasts Shadings A ) =
- WPl
« W P11
» o 780
» o0 )
» & 760 N%
» 750 VAN
» B 7490 /
- ~
- o720 .
» B 70 N
» O 710 h
» e 70
» W P02 N A
v\
W P2 -
» WP P3 <
~ & Dumps

~ M Dumpl
a 8%
aam

CONFIGURING BLAST CUSTOM LABEL

1.  Gotothe Designer tab > Display panel > Labels section > Text field > gear icon. This will
open the Configure Labels window.

Display

Labels @

Text | <Full Name> .
Back Color ~ Fore Color [l ~

Font Tahoma v Size 7

2. Pressthe blue plus buttonto add a new label, rename it to “Blast_ld_Volume”.
a. Create or paste inthe sample formula into the code editor.

ID and Volume

1. using System;

2. usingAlastriRR.Uj

3. using Alastri.RR.Service;

4,

5. public class LabelFormat:ILabel

6. |

1. public string GetLabel(ShadingContext context)

8. {

9. return context.GetLevelName("Pit") + context.GetLevelName("Bench") +"_" +
10. context.GetLevelName("Blast") +"\n" +

1. context.GetReserveString("Volume") +"bcm”;
12.

13. }

14}

15.

16.

b. Double clickin Available Formulas list for code hints.
c. PressTest buttonto check for compile errors.
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Formides

SUndo /" Redo
1| using System;
2| using Alastri.RR.Ui;
using Alastri.RR.Service;

d. Fixallthe errors,if any, and press OK to proceed.

public class LabelFormat : ILabel

public string GetlLabel(ShadingContext context)

context.GetLevelName("Blast™) + "\n" +
context.GetReserveString(“Volume™) + * bcm™;

No errors detected

return context.GetLevelName("Pit") + context.GetLevelName("Bench”) + "_"

+

x oo (]

Now you can select this custom blast label from the Text field dropdown. All custom labels are shown

in bold orange.

@

e & Y &-

-

Display
Labels

Labels

Text Blast_Id

@

i
vyolume

Back

Blasts|

VN

Name

Blast_Id_Volume

Display

Poly &

Shi

Const

Blast Name

F

Sliver Threshold
BlastDigID

Blastld

Volume

Perimeter and Area
<Full Name>

=Volume>

e. Returntothe Report > Plots tab and from the Label field dropdown select that

newly created label.
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| Setup I Designer | Report | Solid Lab |

Reports | Plots
Template: Custom with Block Model - {3}
' Shading: (none) v
Labek Blast_Id_Volume I hd I P1720_1
21,011 bem
Enter text to search... | Clear
P1720
Label 20,586 Bem
!DDHE} — P1720_00201
Blast_Id_Volume 10,117 bem /

CONFIGURING BLASTS CUSTOM SHADING

1.

Go to the Designer tab > Display panel > Blasts/Digs section > Shading field > gearicon.
This will open the Configure Blast Shadings window.

Blasts / Digs
Display Type Blasts v

Polygons 3 Opadty
Solids | @ Opadity

Shading | Blast Type is

2. Pressthe blue plus buttonto add a new blast shading, rename it to “Blast_Type”.

a. Inthe Simple tab drop down the Shading Field and select “Solid: Blast
Type” template.

b. Inthe Values table, populate blast types (contour, production, ramp,
trim) and assign colour to each interval.

Configure Blast Shadings -

[Sooe ] compien |

Shading Fieid: [(Soiid: Blast Type 4

1000

» Blast_Type 800

600
400

200

Production Ramp

Sort Ascending |
—— Clear All Entries Generate Gradient
Sort Descending |
Value Color
» Contour _ -
Production |~
* (77

® cocel || f o
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c. Alternatively, click the Complex tab to open the code editor.
d. Create or paste in the sample formula.

Simple Blast Shading
. using System;

—

2. using System.Collections.Generic;

3. using System.Drawing;

4, using System.Text;

5. using System.LingQ;

6. using Alastri.RR.Uj;

1. using Alastri.RR.Service;

8.

9. public class CustomBlastShading: IBlastShading

10. |

1. public Color GetColor(ShadingContext context) {

12.

13. if(context.BlastType.ToString() == "Contour") return

14.  Color.MediumPurple;

15. if(context.BlastType.ToString() =="Trim") return Color.PaleGreen;,
16. if(context.BlastType.ToString() == "Ramp") return Color.SkyBlue;
17.

18. return Color.BlanchedAlmond,;

19. }

e. Fixallthe errors,if any, and press OK to proceed.

Now you can select this custom blast shading from the Shading field dropdown. All custom shadings
are shownin

Adjust polygons and solids Opacity for a better viewing.

/966 bam | o

Display Type Blasts -
Polygons | @ | | Opadty
Solids | & Opadty

s O

P1720_D0102
58,243 bom

<Blast Type>

:ZSU__—/ <Reserves Volume Check>
—

<Reserves Data Source>

Levels: Reserves|Mine
Levels: ReservesPit
Levels: Reserves\Stage

poration NVIDLA GeForce RTE 2070F

3. Returntothe Report >Plots tab and from the Shading field dropdown select that
newly created blast shading.
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Setup | Designer | Report | Solid Lab
A
]

Reports | Plots

Template: Custom with Block Model * o /

Shading: Blas B
Clear

20,586 hem

P1720_0

. 40,117
Shading

{none)

k8
a. Review the configured plotinthe viewport. You can always go back to the
Template settings to change any display parameters, if desired.

b. Tosavethe plot, right click anywhere in the viewport and select “SAVE" option.

[ Copy

c. Inthe Save As window, specify file name and select a format (available formats
are:*bmp, *.gif, *jpg and *.png).

File name: | Reserves_ M1_P101_720_PLOT

Sawve as type: | JPEG File Interchange Format (*.jpg)
Bitmap Files (".bmp)
Graphics Interchange Format [*.gif)

Portable Metwork Graphics Format (”.pna]

Software Support

Quraimisto give great aftercare and support to all Alastri customers. If you have a problem, try
searching by keyword in the online help documentation, asking a question in the user forums, learning
from our video tutorials or by contacting an Alastri customer support representative.

Documentation Extensive online documentation is accessible through the Help

menu.

Website Software updates are available at www.alastricom.au
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User Forum Learn from the experts at www.linkedin.com/groups/6788736
Video Tutorials Search for Alastrion www.youtube.com
Contact Send your support requests to support@alastricom.au

Sometimes we may link advanced users to preview releases on the Alastri website. Itis possible that
these unstable versions may crash, and if they do, we ask that you copy down the error message and
send itto support@alastricom.au.
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